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 مقدمه 1

یمود آمده است، ها در دو سال اخیر بوجزههای بارگذری و طراحی سانامهتوجه به تغییراتی که  در آئینبا 

ین تغییرات نحوه اعمال انامه و روشهای طراحی آئین ید،با مطالب جدان، بایست مهندسان عزیز و دانشجوی

 .کار ببرندبه ندسی خود افزارهای طراحی را یاد گرفته و در کارهای مهدر  سری جدید نرم

 ،92مبحث ششم مقررات ملی ساختمان ویرایش در جزوه حاضر بارگذاری ثقلی سازه بر اساس 

ساس بر ا حی ساختمانهای بتنیاطر، مویراش چهار 2800استاندار ساس براای بارگذاری جانبی و لرزه

ولادی های فو طراحی سازه ACI318-11نامه ئینو آ 92ختمان ویرایش ای سلمبحث نهم مقررات م

 انجام خواهد شد. AISC360-10 نامهبراساس آئین LRFDبه روش 

 باشد. و سعی شده است کمی Etabs 2015افزاری که این جزوه بر اساس آن تدوین شده است، نرم

 قدیمی شرح داده شود. هاینسخهافزار فوق و تفاوت آن با ر نرمدمطالب جدید 

ن ستفاده از ایباشد و اای میهای طراحی و لرزهنامهضوابط آیین این جزوه شامل مطالب آموزش نرم افزار و

رگزاری بل گردد. چون مطالب تئوری در طوبرای افرادی که از نظر مسائل تئوری مشکلی ندارند توصیه می

 گردد.دوره در کلاس ارائه می

با اعمال نظرات و محترم  واطمینان دارم که این  جزوه نیز بدون ایراد نخواهد بود، امیدوارم دوستان دلسوز 

بنده را در هرچه بهتر شدن این  @gmail.comba.mohammadpourانتقادات خود از طریق ایمیل 

 جزوه یاری فرمایند.

با آرزوی توفیق:

 محمدپور

 94اردیبهشت 

 

 

mailto:ba.mohammadpour@gmail.com
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 شروع ساخت مدل در نرم افزار:   2

  برای شروع مدل به ترتیب زیر عمل می کنیم:

  File > new modelمسیر:

 

 : تنظیمات لازم برای ایجاد یک فایل جدید1شکل

اطلاعات پایه لازم برای مقاطع فولادی بر اساس استاندارد اروپا و ورد نظر واحد متریک، حد مدر شکل بالا وا

 Gridباید  اولیه بعد از تنظیم های طراحی هم بر اساس تنظیمات فوق انتخاب خواهند شد. نامهآئین

line .های مورد نیاز تعریف گردندGrid line اشند. به میها خطوط کمکی برای ساخت هندسه مدل ساز

باشد؛ اما در حالت و پلان معماری هر سازه متفاوت میگذاری ستونتعداد خطوط کمکی با توجه به موقعیت 

و تیرهای اطراف  بندی ستونهاهر راستا برابر است با خطوط آکس کلی تعداد خطوط کمکی در هر سازه برای

 گردند:که بصورت زیر تعریف می ها پله و انتهای طرهراه
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 بندی سازهپلان آکس:  2شکل 

 

 
 (Gridsتعریف مشخصات  خطوط کمکی مدلسازی):  3شکل 

 

S1 

S2 

S3 

S4 
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yو  xها و مشخصات خطوط کمکی راستای تنظیم اندازه:  4شکل

 

 تنظیم ارتفاع و مشخصات مربوط به طبقات سازه :  5شکل

 

S2 

S4 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

͊ 
 

 Addاز قسمت Grid onlyنتخاب گزینه با ا، طبقات پلان و در در نهایت بعد از تنظیم کردن خطوط کمکی

Structural Objectsگردیم.افزار برمیبه صفحه کار در نرم 

 

 

  افزار نمایش محیط کار در نرم:  6لشک

 

 Defineمنوی  ̺

در نرم لاعات اولیهافزار تعریف گردد. اطپروژه در نرم هباستی اطلاعات مربوط ببعد انجام تنظیمات اولیه، می

 گردد.تعریف میDefineنوی از مافزار 

 مشخصات مصالح 1-3

Define > Material propertiesمسیر: 
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 : پنجره تعریف مشخصات مصالح7شکل

 

 4000Psiگیرد. فولادی است که در آمریکا بیشتر مورد استفاده قرار می A992Fy50، 7بر اساس شکل

شخصات میلگردهای طولی مورد م A615Gr60است. همچنین  28Mpaقاومت فشاری معادل مبتنی با 

 باشد.های بتنی میاستفاده در سازه

 :مشخصات مصالح بتنی 

 گردد.یفرض برنامه ویرایش ممصالح بتنی پیشکردن مصالح جدید، برای تعریف مصالح بتنی  بجای اضافه
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  بتنی : تعریف مشخصات مصالح8شکل 

 

 : تعریف مقاومت فشاری بتن 9شکل

E=(3000 푓  +6900)( ) .  
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 الح فولادی:مشخصات مص 

  
 فولادی: پنجره تعریف مشخصات مصالح 10شکل
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 : پنجره تعریف مشخصات مصالح فولادی11شکل

باشد که؛ در به ترتیب تنش تسلیم مورد انتظار و تنش نهایی مورد انتظار می 퐹و  퐹در جدول بالا 

-10طبق جدول  ،هر نوع مقطع فولادیبرای  1-2-3-10بر اساس بند  مبحث دهم مقررات ملی ساختمان

1.15퐹این مقدار  FEMA356قابل تعیین است. اما بر اساس  3-2-1 1.15퐹و    محاسبه شده و در   

 شود.نامه برآورد میهنگام تنظیم کردن پارامترهای طراحی، برای هرمقطع جداگانه بر اساس جدول آئین

 

  مشخصات میلگردها 

ات باشد. لذا در این قسمت مشخصات میلگردها نیز جداگانه قابل تعیین میمشخص ETABS2013در 

 شود.مکانیکی میلگردها بر اساس مبث نهم مقررات ملی ساختمان تعیین می
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 : پنجره تعریف مشخصات میلگردها 12شکل
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 : پنجره تعریف مشخصات مکانیکی میلگردها 13شکل

 .استاز مبحث نهم مقررات ملی ساختمان قابل محاسبه  ند زیرباساس  بر 퐹و  퐹در جدول بالا 

  
 باشد.می 1.25풇풚برابر  1.47풇풚풅مقدار  2-1-4-4-23-9دربند 
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 تعریف مشخصات مقاطع:  3-2

 Define > section properties > Frame Sectionمسیر: 

 مقاطع فولادی: 3-2-1

 فراخوانی مقاطع فولادی: 3-2-1-1

 

 و فراخوانی مقاطع : پنجره تعریف مشخصات مقاطع14شکل

 

 

 

فراخوانی مقاطع از این قسمت انجام 

شود. در فراخوانی مقاطع می

-فولادی، مقاطع تک فراخونی می

 شود.

ساخت تیرورقها و مقاطع از این 

 شود. قسمت انجام می
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 ساخت مقاطع تیر روقها: 3-2-1-2

 
 جدید: پنجره تعریف مقاطع 15شکل

  

 مقاطع فولادی

تمام مشخصات  در این کشو

هندسی مقاطع برای ساخت 

تیر ورق در اشکال مختلف، 

 گردد.بصورت دستی وارد می

بقیه اشکال تیر ورق 

نیز به همین صورت 

 ساخته می شود.

 مقاطع کامپوزیت

 و دلخواه مقاطع خاص

 ساخت مقاطع بتنی
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 : پنجره تعریف ابعاد هندسی مقاطع تیرورقها16شکل

 

 
 : نمایش مشخصات هندسی تیر ورقها17شکل

 

 :Section Designerنامه ساخت مقاطع مرکب فولادی در بر 3-2-1-3

های فولادی، مبحث شود. باید توجه کرد که در طراحی سازهستفاده می SDقسمت از افزار برای ساخت مقاطع دوبل در نرم

غیر فشرده  وای، فشرده ها، مقاطع فولادی را از نظر ابعاد به مقطع فشرده لرزهپذیری سازهدهم مقررات ملی بر حسب شکل

لازم به ذکر است که  اعمال کرده است. که بر حسب شرایط استفاده، برای هر کدام از مقاطع محدودیتهایینماید. تقسیم می

افزار نماید. از طرفی نرمافزار فشرده و غیر فشرده بودن مقطع را کنترل مینرم LRFDفولادی به روش  هایدر طراحی سازه

بنابراین باید مقاطع ساخته شده در این قسمت  شناسد.شوند، بصورت غیرفشرده میساخته می SDمقاطعی را که در قسمت 

 افزار معرفی گردد تا در شناسائی مقاطع فشرده دچار مشکل نگردد.ر زیر آورده شده است؛ به نرمدروشی که  به
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 برای ساخت مقاطع مرکب SD: انتخاب 18شکل

 
 SD: نحوه انجام تنظیمات برای ورود به صفحه 19شکل

 

0 
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 SD: ساخت مقطع مرکب در 20شکل

 

 (:Auto select list)کار اص خودساخت مقاطع در حالت اختص 3-2-1-4

 

 Auto select list: انتخاب 21شکل 

X Center فاصله آکس پروفیل از محور :Y 

Y Centerاصله آکس پروفیل از محور : فX 
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 فولادی برای تیرها Auto: ساخت مقطع 22شکل

 

 

  

 

 

 

 

 

 

این کار برای ستونها و 

مهاربندها نیز انجام می شود. 

در این روش برنامه از بین 

مقاطع موجود اولین مقطع را 

که ظرفیت آن برای المانها 

جوابگو باشد انتخاب می کند. 

این روش اختصاص مقاطع 

برای افرادی که از تجربه 

کافی برخوردار نیستن کمک 

که سازه بهینه می کند 

طراحی گردد. اما در این 

روش تیپ بندی مقاطع کار 

 دشواری خواهد بود.

در بعضی از موارد دیده می شود که مهندسین طراح از مقاطع آماده که در سایتها تحت عنوان مقاطع ایرانی نامگذاری شده اند توجه: 

بروز اشتباه در مشخصات مقاطع استفاده نگردد ولی در صورت استفاده باید که از مقاطع آماده به علت  ن استآاستفاده می کنند؛ توصیه بر 

 مشخصات مقاطع ساخته شده با جدول اشتال هم خوانی داشته باشد.
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 مقاطع بتنی: 3-2-2

 

 

 

 : ساخت مقطع ستون بتنی23شکل

برای ساخت مقاطع تیر و ستونهای 

مربع و مستطیل از این گزینه 

 استفاده می شود

 مقطع ستون
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 تنظیم مشخصات مقطع ستون بتنی : 24شکل

 

حاسبه مباشد؛ فلذا فقط برای شده برای تحلیل خطی لازم نمیدر تعریف میلگردهای عرضی مقادیر وارد 

 ، قطر میلگرد خاموت باید صحیح وارد شود. مناسب پوشش بتنی

 اید مواردبدر ستون های تحت نیروی زلزله و برای سازه های با شکل پذیری متوسط و نیز شکل پذیری زیاد 

 زیر را منظور کرد :

لازم به ذکر است که به علت عدم دقت کافی در 

ی سازه های بتنی و احتمال بروز اشتباه در اجرا

پیاده کردن نقشه در کارگاههای ساختمانی، تا 

جایی که امکان دارد تعداد میلگردها در هر دو 

 جهت با یکدیگر برابر باشد.

رنامه انتخاب شود ب Checkedاگر حالت 

ظرفیت مقطع را کنترل کرده و در نهایت 

برای طراحی از ظرفیتی که مشخص شده 

کند. اما اگر است استفاده می

انتخاب شود برنامه برای   Designedحالت

ابعاد و تعداد میلگرد مشخص شده  سطح 

 آورد. مقطع فولاد لازم را بدست می

 میلگردهای عرضی
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م مبحث نه اساس ضوابط ها باید حداقل فاصله میلگردها بردر هنگام انتخاب تعداد میلگرد برای ستونتوجه:

 مقررات ملی بررسی گردد.

 

 مقطع تیر
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 : ساخت مقطع تیر بتنی 25شکل

 : تنظیم مشخصات مقطع تیر بتنی 26شکل 
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 تعریف پوشش کف 3-3

 سقف تیرچه و بلوک:  3-3-1
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 Define > Section properties > Deck Sectionمسیر: 

 

 

 

 و بلوک ساخت مقطع سقف تیرچه: 27شکل
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 : تنظیمات مشخصات سقف تیرچه و بلوک28شکل
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 سقف کرومیت 3-3-2

اخت ر ستدر سیستم سقف کُرمیت از تیرچه های فولادی با جان باز در ترکیب با بتن استتفاده متی شتود. د

ود. بترای تیرچه های مذکور از یک تسمه، در بال تحتانی و نیز یک میلگرد خم شده در جان استفاده می شت

 اق ضتربی ،پرکردن فضای خالی بین تیرچه ها از قالب های ثابت مانند بلوک های سیمانی، پلی استایرن، ط

ع سته به نوبود. فواصل تیرچه ها قالب های موقت فولادی )کامپوزیت ( و یا هر پرکننده سبک استفاده می ش

وشتانده متی سانتی متر بتن پ 10الی  4سانتی متر متغیراست ، روی سقف نیز با  100سانتی تا  73قالب از 

 شود. 

 

متی باشتدو تیرچه ها از نوع خود ایستا بوده و به همین علت هیچ نوع شمع بندی در زیر سقف متورد نیتاز ن

ی به تنهای که بتوانند وزن بتن خیس، قالب ها و عوامل اجرایی سقف را تیرچه ها به نحوی طراحی می شوند

ه بتمقاومت مشخصه خود می رسد ، تیرچته هتای فتولادی بتا بتتن  %75پس ازاین که بتن به  تحمل کنند.

 صورت یک مقطع مختلط وارد عمل شده و بارهای مرده و زنده سقف را تحمل می کنند.
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 سقف تیرچه و بلوک کُرمیت

یتن اتداول شدن سقف های تیرچه و بلوک سنتی برخی از مشکلات سیستم طاق ضربی مرتفع شد. امتا با م

مع بنتدی سقف ها مشکلات دیگری را به همراه خود پدید آوردند که عمده ترین آنها ضرورت استفاده از شت

 در زیر سقف است.

 

 بتا 1363ل ان تحمیل می کند. در ساشمع بندی علاوه بر دست و پاگیر بودن هزینه زیادی را نیز بر ساختم

 ی رفت عملادر این سیستم بعنوان قالب ثابت بکار م استفاده از بلوک کُرمیت به جای طاق ضربی که قبلا

 سقف تیرچه وبلوک کُرمیت وارد بازارشد.

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̺̾ 
 

ای ت اجتراین سقف به علت خود ایستا بودن تیرچه ها نیازی به شمع بندی ندارند و به همین علت از سترع

کتان باربر ام بسیار بالایی برخوردار می باشد. اجرای این سقف بر روی اسکلت های فولادی بتنی و دیوارهای

 پذیر می باشد.

 

 سقف پلیمری کُرمیت

 ای وکتهپ های بلوک و  در راستای سبک سازی ساختمان، این شرکت هم زمان با ستفاده از قالب کامپوزیت

ن نستوز در . استفاده از بلتوک هتای پلتی استتایراست کرده ساختمان در ریپلیم مصالح از استفاده به اقدام

 می شود. %7و کاهش فولاد مصرفی سازه تا حدود  %20سقف باعث کاهش مصرف تیرچه تا حدود 
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دد. در سهولت اجرای این نوع سقف، باعث افزایش سرعت اجرا و درنیتجه کاهش هزینه های اجرایی می گتر

استب ی حمل و نقل نیز صرفه جویی قابل ملاحظه ای صورت می گیرد. شتیارهای منعین حال در هزینه ها

استتفاده  در جهت بهبود می گردد. سقف زیر در خاک و گچ پیوستگی  ایجاد شده در زیر این بلوک ها باعث

 از مصالح پلیمری، بخش تحقیق و توسعه این شرکت مشغول مطالعات و بررسی های بیشتر می باشد.

 وزیت کُرمیت سقف کامپ 

 بتا همتراه معمتولا و شود می انجام باز جان با های تیرچه با سیستمهای معمول کامپوزیت در امریکا عینا

 ایتن رد.  شتود متی ریختته بتن آن روی بندی آرماتور و عرشه عنوان به موجودار فولادی ورق یک گذاشتن

پوزیتت سیستتم قالتب کام طراحی در. شود نمی احاطه بتن با نیز جان قطعات و است ماندگار قالب سیستم

از این  تر باشد. کُرمیت، نظر بر آن بوده که علاوه بر سرعت و تطبیق با آیین نامه ها ، هر چه ممکن اقتصادی

طعتات جتان را قجان تیرچه با بتن پر شود کته بتتوان  "ثانیاقالب باید قابل استفاده مداوم باشد،  "اولارو 

ه بتا از لرزش سقف نیز کاسته شتود. سیستتمهای کامپوزیتت رایت  در ایتران کتاقتصادی تر طراحی نمود و 

  تیرآهن ساده یا لانه زنبوری با تیر ورق استفاده می شوند، دارای جان باز نیستند.
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ر جتدا متی در وهله اول قالب های سقف کرمیت سه قطعه بوده و برای باز کردن ، قطعات آن باید از یکتدیگ

رتجاعی این شرکت این قالب با بهینه سازی و استفاده از خاصیت تغییر شکل ا RDش شد ، با تحقیق بخ

الب از قولیه بتن ااین قالب در بین تیرچه ها قرار گرفته و بعد از گیرش   فولاد به قالبی یکچارچه تبدیل شد.

ی گردد و آوری مزیر سقف در آورده می شود . این قالب محاسن بسیار زیادی دارد و با سرعت چیده و جمع 

ت متورد با دقت مختصری , بارها قابل استفاده است. این قالب هم اکنون در پروژه های مختلتف ایتن شترک

م تیرچه آخرین بررسی ها و دستاوردها نشان داد که بهتر است جهت تطبیق سیستم با سیست استفاده است.

ی صرفه جوی ی در دال فوقانی و در نتیجهبلوک و استفاده از آرماتور حرارتی یک جهته و حذف آرماتور خمش

ه بتا رعایتت سانتی متر باشد. مزیت این قالب در آن است ک 75اقتصادی، فاصله لب با لب تیرچه ها حداکثر 

هتم  .نظور نموددیگر شرایط آیین نامه می توان آرماتور دو جهته را حذف و فقط آرماتور عمود بر تیرچه را م

ه عرضته د خود را به انتخاب مصرف کننده در فواصل و ارتفاع مختلتف آمتاداکنون این شرکت قالبهای جدی

 25تتا  20 سانتی متتر و بتا ارتفتاع 95سانتی متر تا  85نموده است. فاصله محور به محور تیرچه ها حدود 

 ازه و طتولسسانتی متر، بسته به انتخاب خریدار و با مشاوره دفتر فنی شرکت و نوع تیرآهنهای مصرفی در 

 است.انه ده

 سقف کاذب 

پوزیت به بعد در اولین سقف های کام 1365سقف های کاذب اولیه به صورت قطعات پلاستیکی در سالهای 

که  ( باعث گردیدCreepکُرمیت به کار رفت. اما گران بودن مصالح ، نچسبیدن به گچ و خاک و خزش )

مهای کلها و فروانیزه به صورت رابیتس در شاستفاده از آن مقید گردد. از سوی دیگر انواع تولیدات ورق گال

 اد.دحصول سوق مختلف و تولید مواد اولیه آن )ورق گالوانیزه( در ایران ، ما را به سمت استفاده از این م
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 سقف ضربی کُرمیت

مین هوده و به به علت اجبار در استفاده ار مصالح فشاری از زمان های قدیم استفاده از طاق قوسی متداول ب

ت عمتده جهت استفاده از سیستم طاق ضربی نیز به عنوان نوعی طاق قوسی رواج داشته است. وجود اشکالا

ف زیتاد در عملکرد سقف های ضربی با تیرآهن مانند عدم ایجاد یک دیافراگم مناسب بین ستون ها و مصتر

« ربی کُرمیتت سقف ض» بهینه  با ارائه طرحی 1356فولاد در مقایسه با مقدار باربری ، باعث شد تا در سال 

ند یتک در سیستم طاق ضربی کُرمیت وجود بتن روی سقف می توا نسبت به اصلاح این سیستم اقدام گردد.

 ی در مصرفدیافراگم مناسب بین ستون ها ایجاد کند و همچنین به علت بازبودن جان تیرچه ها مقدار زیاد

 .شود می فولاد صرفه جویی 

 

استفاده نمی شود ، اما برای پروژه های کوچک و یا دور افتاده ، هنوز  یتم در انبوه سازاگر چه از این سیس

   هم کاربرد دارد.
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  مزایای سقف کرمیت 

  کاهش هزینه 

  امکان حذف کش ها 

   سرعت و سهولت اجرا 

  عدم نیاز به شمع بندی 

  پایین بودن تنش در بتن 

  )سهولت اجرا داکت )بازشو 

  رد فولاد در زیرسقف حذف 

  امکان اجرای همزمان چند سقف 

  مقاومت نهایی و شکل پذیری بالا 

  )یکنواختی زیر سقف )مصرف گچ و خاک کمتر 

  امکان نظارت بر اجرای سقف در طول عملیات اجرایی 

   (%20کاهش مصرف بتن و وزن کمتر سقف )حدود 

  اجرای سقف(ف و اسکلت )مقاومت در طول سق  یکپارچگی 

  امکان طراحی و اجرای سقف با دهانه ها و باربری های خاص 

 عدم نیاز به شمع بندی 

 نایی تحملطراحی سقف کرمیت با این فرض انجام می شود که تیرچه ها به تنهایی )قبل از گرفتن بتن( توا

 در بندی عشم به نیازی کرمیت سقف بنابراین. باشند داشته را اجرایی عوامل و  وزن خود، بلوک، بتن خیس

 . ندارد اجرایی عملیات مراحل از یک هیچ
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 سرعت و سهولت اجرا 

ی شتود. در این سیستم، اجرای سقف نسبت به سیستم های مشابه آسانتر بوده و با سرعت بیشتری انجام مت

ساعت پس از بتن ریزی، روی سقف قابتل رفتت و آمتد و بارگتذاری ستبک بتوده و متی تتوان عملیتات  48

 اختمانی را ادامه داد که این مزیت موجب سرعت در روند عملیات ساخت می گردد. س

 امکان اجرای همزمان چند سقف

سقف را  می توان چند با توجه به این که در سیستم سقف کرمیت هیچ گونه شمع بندی وجود ندارد. عملا

ر بترای هتا انجتام داد. ایتن کتابرای بتن ریزی آماده کرد و هم زمان عملیات بتتن ریتزی را بتر روی ستقف 

 ساختمان های با طبقات زیاد و یا زیربنای کم بسیار مقرون به صرفه و مناسب است. 

 یکپارچگی سقف و اسکلت

د مانند به علت جوش شدن تیرچه ها به اسکلت، پس از گرفتن بتن، سقف و اسکلت یکپارچه شده و می توان

ن نی نیز بتا در نظتر گترفتن قتلاب هتای مخصوصتی، امکتایک دیافراگم صلب عمل کند. در اسکلت های بت

 یکپارچگی بیشتری ایجاد می شود. 

 

 

 امکان حذف کش ها

با توجه به یکپارچگی سقف و اسکلت، می توان کش ها )اعضای غیرباربر( را حذف کرد . حذف کش ها علاوه 

نازک کاری را به حداقل می بر صرفه جویی در مصرف فولاد باعث یکنواختی بیشتر زیر سقف شده و عملیات 

 رساند. 
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 پایین بودن تنش در بتن

یی وامل اجرابه علت خود ایستا بودن تیرچه ها)تیرچه قبل از گرفتن بتن می تواند وزن بلوک، بتن خیس و ع

ف هتای آزمتایش بارگتذاری روی ستق را به تنهایی تحمل کند( تنش ایجاد شده در بتن بسیار پایین استت .

ه ت پتایین بتنهایی بتن آنها کمتر از مقدار مورد نظر بوده نشان داده که بتتن بتا مقاومت کرمیت که مقاومت

 ظرفیت باربری سقف لطمه ای وارد نمی سازد. 

 امکان طراحی و اجرای سقف با دهانه ها و باربری های خاص

. ارددر سیستم سقف کرمیت امکان طراحی و اجرای سقف با دهانته هتای بلنتد و بارهتای ستنگین وجتود د

هتر متورد  تن بر متر مربع اجرا شده که در 7متر و همچنین سقف با شدت بار  5/12تاکنون سقف با دهانه 

 آزمایش های بارگذاری ، ایمنی سقف را تایید کرده اند. 

 حذف رد فولاد زیر سقف 

به  اثر داغ آهن در سقف های ضربی به صورت خط تیره ای روی گچ مشاهده می شود ولی در سقف کرمیت

 نقاط سقف علت پایین تر بودن سطح بلوکها از تیرچه ها، پوشش گچ و خاک در زیر تیرچه ها نسبت به بقیه

یرچه هتا بیشتر است و همین امر سبب کاهش جذب ذرات معلق می شود. بنابراین سایه فولاد بال تحتانی ت

 مشاهده نمی گردد. 

 سهولت اجرای داکت )بازشو(

بور لولته عسانتی متر محور به محور ( ایجاد داکت درسقف جهت  100تا  73ها ) به علت فاصله زیاد تیرچه

ن احتی امکتاهای تاسیساتی نصب دودکش موتورخانه و شومینه نصب توالت ایرانی و یا عبور کانال کولر به ر

 پذیر است و نیاز به قطع کردن تیرچه ها نمی باشد. 
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  اجرا طول در سقف اجرای بر  رتنظا

قف سخاصی جهت نظارت بر سقف ها آموزش دیده اند تا در صورت تمایل مشتری در طی اجرای اکیپ های 

چته از  ها نظارت مستمر بر نحوه عملکرد مجریان صورت پذیرد و از سلامت اجرای سقف چه از نظتر فنتی و

 نظر زیبایی اطمینان کامل حاصل گردد.

  کاهش مصرف بتن و وزن کمتر سقف

نسبت بته  %20سانتی متر محور به محور ( از مصرف بتن در حدود  75چه ها )حدود به علت فاصله زیاد تیر

ک ای و بلو وزن سبک تر می گردد. استفاده از بلوک های پوکه تیرچه و بلوک معمولی کاسته شده و نهایتا

 های پلی استایرن کرمیت یا سیستم کامپوزیت نیزدر کاهش وزن موثر است. 

 ی بالامقاومت نهایی و شکل پذیر

کل محاسبات و آزمایش های بارگذاری روی سقف نشان می دهد که گسیختگی این سیستم پس از تغییر ش

 . است مطلوب ایمنی نظر از سقف رفتار این و  «گسیختگی نرم» های بسیار زیاد اتفاق می افتد. 
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 Define > Section properties > Deck Sectionمسیر: 

 

 سقف کرومیت: تنظیمات مشخصات 29شکل
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 و عرشه فولادی یتسقف کامپوز 3-3-3
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 Define > Section Properties > Deck Sectionمسیر تعریف مشخصات سقف کامپوزیت: 
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 : تنظیمات مشخصات سقف کامپوزیت30شکل

 Define > Section Properties > Deck Section: عرشه فولادیمسیر تعریف مشخصات سقف 

 قف، از ورقباشد؛ با این تفاوت که در این سسقف عرشه فولادی تقریبا به نوعی همانند سقف کامپوزیت می

 مراجعه بفرمائید. 1شود. برای مطالعه بیشتر به پیوست موجدار نیز استفاده می

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

͉͉ 
 

 

  : تنظیمات مشخصات سقف عرشه فولادی31شکل
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       Define > Section Properties > Deck Section دال بتنی:  3-3-4

 

 : تعریف سقف دال بتنی32شکل

 

 

 با خاصیت غشائی : تنظیمات مشخصات سقف دال بتنی33شکل                                                                  

Membrane : سقفهای غشائی دارای خاصیت پخش بار

گونه شوند هیچهستند و دالهایی که با این خاصیت مدل می

افزار فقط اتصالی بین تیر و سقف وجود نخواهد داشت و نرم

کند و قادر برای انتقال بارها از این نوع سیستم استفاده می

 نخواهدبود دال را تحلیل نماید.
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 : تنظیمات مشخصات سقف دال بتنی با خاصیت خمشی34شکل                                              

     Define > Section Properties > Wall Sectionsدیوار بتنی: 

  

  : تعریف دیوا برشی بتنی35شکل

Shell : سقفهای خمشی دارای پخش بار بصورت دوطرفه

افزار ابتدا این سیستم را تحلیل کرده و از منیستند بلکه نر

اتصال خمشی برشی که بین تیر و سقف وجود دارد طریق 

باشد به تیرها منتقل تلاشها را که ناشی از خمش و برش می

 کنند.می
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  : تنظیم مشخصات دیوار برشی بتنی36شکل
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 حالات بار استاتیکی وارد بر سازهتعریف  4-3

 بصورت زیر می باشد: 1392بر اساس مبحث ششم مقررات ملی سال  هساز بارهای وارد بر

 : باری است که مقدار،  جهت و نقطه اثر بار در طول عمر سازه ثابت است. باراستاتیکی

 ها در طولسه آنمقدار وجهت بارگذاری یا هر  ،: باری است که یکی از پارامترهای نقطه اثربار دینامیکی

 عمر سازه تغییر کند.

ی های مختلفسمتقها، همچنین بار ای سازهها و اجزای سازه: بار های مرده عبارتند از وزن المان مردهبار 

 برداری سازه ثابت هستند مانند بار سقف، تیر، ستون و...از سازه که در طول عمر بهره

 هستند  مرده : وزن تجهیزات و تاسیسات ثابت که در طول عمر سازه ثابت خواهند بود جزء بار های1نکته

ایر تمان و یا سرداری از ساخبباشد که در حین استفاده یا بهرهبار زنده بار غیر دائمی می بارهای زنده :

بار  برف، باران، ، بارهای محیطی مانند بار باد، بارشامل بارهای حین ساختو شود ها به آن ها وارد میسازه

 یا سایر بارها.بار سیل و  ،زلزله

باید رود، ها به کار میها و سایر سازهای که در طراحی ساختمانبار زنده ترده یکنواخت :بار زنده گس

ت داده های یکنواخاز حداقل بار نباید  بیشترین بار مورد انتظار برای کاربری مورد نظر بوده و در هیچ حالتی

جاز کمتر های مکاهش بحث ششم مقررات ملی ساختمان ، با در نظر گرفتن میزانم  1-5-6شده در جدول 

 باشد.
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ن باید به ای ارگذاری آنباشد. در هنگام بترین عضو در هر سازه می: طره یا بالکن به عنوان خطرناک2نکته

 ند آنها  قرارهمانیا و  لباسشویی قیل متمرکز مانند یخچال، ها بارهای ثم که نباید در طرهدقت کنی نکته 

 داده شود.

ر اساس بی یکنواخت خواهد بود، ارهای طراحی که به صورت گستردهها بسازه : در بارگذاری زنده3نکته

سازه که  بخشهر  کنیم که بر اساسلذا در برآورد این بارها باید دقت  . برآورد خواهد شد 1-5-6جدول 

ک ساس در یابر این ه خود را از جدول  برداشت نماییم. تواند تغییر کند بار زنده مربوط بکاربری آن می

م ها متفاوت از و سایر قسمتهها های مختلفی از آن مانند راهرو، اتاقتواند در بخشسازه بارگذاری زنده می

 را برای هانآمقدار  بیشترین توان می ،درصورتیکه اختلاف زیادی مابین این بارها وجود نداشته باشدباشد. 

 .ها در نظر گرفتی بخشهمه

 بار گسترده تیغه بندی :

 

 

ه عنوان بیشتر باشد وزن آن ب Kg 200: در صورتیکه وزن هر مترمربع سطح دیوارهای جدا کنند از 4هنکت

ده حساب بار مرده در نظر گرفته شده در محل واقعی خود اعمال می گردد یعنی نباید برای آن بار گستر

 کرد.

 : وزن تیغه بندی جزء بارهی زنده می باشد اگر نکته بالا شامل شود 5نکته

ار تقسیم کننتذه بیشتر باشد نیازی به در نظر گرفتن بار زنده ی دیو kg400اگر حداقل بار زنده از تثناء: اس

 نیست .
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 ده بیش ازنامناسب ترین وضع بارگذاری : در تیر های یکسره و در قاب های نامعین در مواردی که بار زن

400kg   تلف باید طوری یری بار زنده در دهانه های مخبرابر بار مرده است موقعیت قرار گ 5/1و یا بیشتر از

وه ور کافیست علابرای این منظ .ایجاد نماید ایسازهدر نظر گرفته شود که بیشترین اثر مورد نظر را در عضو 

 های بارگذاری زیر در نظر گرفته شود:ها حالترار دادن بار زنده در تمام دهانهبر حالت ق

 دهانه مجاورالف( قرار دادن بار زنده در دو 

 ها نده به صورت یک در میان در دهانهب( قرار دادن بار ز

-جزئیات، تهیه و به سازه اعمال میای و معماری ایلهای سازهبارگذاری ثقلی سازه بر اساس دت

 گردد. 

 

 ار دیوارهاب

 

 

 

250250002.0 mkg :سنگ تراورتن 

242210002.0 mkgملات ماسه سیمان : 

21708502.0 mkgآجرکاری باآجر مجوف و ملات ماسه سیمان : 

232160002.0 mkgملات گچ و خاک : 

213130001.0 mkgاندود گچ : 
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 2307 mkg 

ها استفاده جرهبه منظور در نظرگرفتن اثر بازشوها و پن 0.7برای بارگذاری دیوارهای نمادار از ضریب کاهش 

 شود.می

22157.0307 mkg 

 

 

 

21708502.0 mkg:آجرکاری با آجر مجوف و ملات ماسه سیمان 

232160002.0 mkg :ملات گچ و خاک 

213130001.0 mkgاندود گچ : 

 2215 mkg 

 

mkg5.6239.2215: شودبار خطی دیوار که به تیرهای کناری وارد می  
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2858501.0 mkg:آجرکاری باآجر مجوف و ملات ماسه سیمان 

248160003.0 mkg  :ملات گچ و خاک 

213130001.0 mkgاندود گچ : 

 2146 mkg 

 

 

 

21708502.0 mkg:آجرکاری باآجر مجوف و ملات ماسه سیمان 

264160004.0 mkg :اکملات گچ و خ 

226130002.0 mkgاندود گچ : 

 2260 mkg 
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 بارپله

 

 :ی وزن هر گام پلهمحاسبه

kg33250004.03.01.1    :سنگ کف افقی 

kg8.8250002.016.01.1    م: سنگ قائ 

kg651.1210028.02.0
2

1
   :آجرکاری باآجر مجوف وملات ماسه سیمان 

  kg107   :وزن هرگام پله 

 : A-Aبرش 

mkg5.41225001.115.0    :وزن دال بتنی 

mkg5.2616001.1015.0    :گچ و خاک 

mkg15.713001.1005.0     :کگچ وخا 

 mkg743:وزن واحد طول شیبدار پله 

 :است ریز جدول صورت بهی بارگذار خلاصه
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 بارزنده دیوارجانبی نمادار بی بدون نمادیوارجان هابارتیغه ی سقفبار مرده طبقه

   - 2kg/m 500 بام
 6مبحث  1-5-6جدول 

 92ویرایش سال 

   - 2kg/m 500 خرپشته
 6مبحث  1-5-6جدول 

 92ویرایش سال 

   2kg/m 500 2kg/m 001 طبقات
 6مبحث  1-5-6جدول 

 92ویرایش سال 

   - kg/m 743 هاپله
 6مبحث  1-5-6جدول 

 92ش سال ویرای

 

 

2215 mkg2215 mkg

2215 mkg2215 mkg

2215 mkg2215 mkg

2215 mkg2215 mkg

 بار گسترده نوع کاربری ردیف

 کیلو نیوتن بر متر مربع

بار متمرکز کیلو 

 نیوتن

   بام ها 1

 1,3 1,5 بام های معمولی تخت.شیب دار قوسی 1-1

 1,3 0,5 بام با پوشش سبک 1-2

  5 بام های داری گلخانه و باغچه 1-3

 1,3 )غیر قابل کاهش( 0,25 بام هایی با پوشش پارچه ای با سازه اسکلتی  1-4

  بسته به نوع کاربری قاب های نگه دارنده یک فضابند 1-5

)غیر قابل کاهش .فقط به اعضای  0,25 بام هایی با امکان تجمع و ازدحام 1-6

 قاب ها وارد میشود(

1 

   سالن ها و محل های تجمع و ازدحام  2

 ی ثابت سالن های عمومی و محل های تجمع داری صندلی ها 2-1

 )چسبیده به کف(

3  

  5 سالن های عمومی و محل های تجمع فاقد صندلی های ثابت 2-2

  5 سالن های غذاخوری و رستورانها 2-3

  5 سینما وتئاتر ها 2-4

  7,5 صحنه سینما وتئاتر 2-5

  7,5 سالن های اجرای مراسم گروهی .اجرای سرود و... 2-6
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 و بار زنده متمرکز کف ها 0Lای زنده گسترده یکنواخت حداقل باره 1-5-6جدول 

 

  6 اشبستان مساجد وتکای 2-7

  5 سالن انتظار و ملاقات  2-8

  6 پایانه های مسافربری 2-9

   راهروها و راه پله ها و بالکن ها 3

  5 راه روهای مراکز تجمع و ازدحام واقع در طبقه همکف)ورودی( 3-1

  مطابق بار زنده اتاق های مجاور راه روهای مراکز تجمع و ازدحام واقع در سایر طبقات 3-2

 1,3 5 راه پله ها و راهای منتهی به دربهای خروجی 3-3

 1,3 5 راه پله اضطراری 3-4

 1,3 2 راهرو دسترسی برای امور تعمیر و نگهداری و تاسیسات  3-5

برابر بار زنده کف اتاق های متصل به  1,5 بالکن ها 3-6

کیلو نیوتون  5آن ها لازم نیست بیش از 

 بر متر مربع در نظر گرفته شود

 

 نوع کاربری  ردیف 
 بارگسترده

 کیلو نیوتن بر متر مربع

 بار متمرکز

 کیلو نیوتن

   ساختمان ها و مجتمع های مسکونی 4

  2 راهروها(-انبار-اتاق ها و سایر فضاهای خصوصی شامل )سرویس ها 4-1

  5 اق های محل تجمع و راهروهای مرتبط با آن ات 4-2

   فروشگاه ها هتل ها  5

  2 اتاق ها و سایر فضاهای هتل ها.مهمان سراها . خوابگاه ها  5-1

 4,5 5 طبقه همکف)ورودی(فروشگاه های کوچک و خرده فروشی  5-2

 4,5 3,5 کف سایر طبقات فروشگاه های کوچک و خرده فروشی  5-3

 4,5 6 همه طبقاتفروشگاه های عمده فروشی  5-4

   فرهنگی کتابخانه هاساختمان های آموزشی  6

 4,5 2,5 کلاس های درس .آزمایشگاه های سبک 6-1

 4,5 3 اتاق های مطالعه 6-2

 مخازن کتاب یا اتاق بایگانی با قفسه های ثابت  6-3
 به ازای هر متر ارتفاع . 2,5

 7,5حداقل 
4,5 

 زن کتاب یا اتاق بایگانی با قفسه های متحرکمخا 6-4
 به ازای هر متر ارتفاع 4

 10حداقل 
7 
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 و بار زنده متمرکز کف ها L0ای زنده گسترده یکنواخت حداقل باره 1-5-6ادامه جدول 

 

 هاو بار زنده متمرکز کف 0Lکنواخت ای زنده گسترده یحداقل باره 1-5-6ادامه جدول 

 4,5 5 راه رو های طبقه همکف )ورودی( 6-5

 4,5 4 راه رو های سایر طبقات  6-6

   ساختمان های اداری 7

 9 2,5 دفاتر کار معمولی  7-1

 9 4,5 اهروهای طبقه همکف )ورودی (ر-سالن انتظار و ملاقات 7-2

 9 3,5 راه رو های سایر طبقات  7-3

   ساختمان های صنعتی  8

 9 6 کارگاه های صنعتی سبک 8-1

 11 10 کارگاه های صنعتی متوسط 8-2

 14 12 کار گاه های صنعتی سنگین  8-3

   ورزشگاه ها و تاسیسات تفریحی  9

  3,5 یلیارد و...ب-سالن های ورزشی سبک مانند تنیس روی میز 9-1

  5 سالن های ورزشی و تمرینات بدنی  9-2

  5 ورزشگاه های داری صندلی ثابت  9-3

  6 ورزشگاه های فاقد صندلی ثابت یا داری نیمکت 9-4
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 برفبارگذاری 

 نوع کاربری  ردیف 
 بار گسترده

 کیلو نیوتن بر متر مربع 

 بار متمرکز

 کیلو نیوتن

   بیمارستان ها و مراکز درمانی  10

 4,5 2 اتاق های بیمار 10-1

 4,5 3 اتاق های عمل .آزمایشگاه ها  10-2

 4,5 5 راهرو های طبقه اول 10-3

 4,5 4 ی سایر طبقات راهرو ها 10-4

   محل عبور و پارک خودروها  11

 20 3 کیلونیوتن 40محل عبور و پارک خودروهایی با وزن حداکثر  11-1

 30 6 وتنکیلو نی 90تا   40محل عبور و پارک خودروهایی با وزن حداکثر  11-2

 36 12 معابر و بخش هایی از محوطه با امکان عبور کامیون  11-3

   مواردسایر  12

  15به ازای هر متر ارتفاع مفید.حداقل  5 سردخانه ها 12-1

  5 آشپزخانه های صنعتی و رخت شوی خانه ها  12-2

  1 تعبیه انبار سبک در فضای داخل سقف کاذب  12-3

  6 انباری های سبک 12-4

  12 انباری های سنگین  12-5

  7,5 موتور خانه ها  12-6

  4 پمپ و نظایر آن ی هواساز اتاق ها 12-7

  3 محل فرود بالگرد  12-8

 9 2,5 کف کاذب در فضاهای اداری  12-9

 9 5 کف کاذب برای اتاق های کامپیوتر  12-10

 3,6 اتاق آسانسور 12-11

 )بر روی  1,3

 سطحی برابر 

 50*50با 

 میلی متر 

 وارد شود(

  1 هرگونه ساختمان دیگر 12-12
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 آید.بدست می 92سال  بارگذاری برف نیز بر اساس مبحث ششم مقررات ملی ویرایش

g.Ps.Ie.Ct.Cs=0.7 CrP 

2Pr=0.7*1*1*0.9*1*150=94.5 kg/m 

 gP:بار برف زمین-sI :ضریب اهمیت برف-eC: گیریبرف-tC: ضریب دما-SC: ضریب شیب 

 rP :  بار برف در بام برای حالت متوازن میباشد 

 ررات ملی ساختمان قابل استناد است.مبحث ششم مق 1-7-6)بار برف زمین( از جدول  gP : 6نکته

 

 ر بترف چنتین: بار برف منطقه برای تعدادی از شهر ها مطالعه نشده است بنابراین در پیدا کردن بتا 7نکته

 شهرهایی میتوان باربرف منطقه نزدیک ترین شهر به آن را مدنظر قرار داد.

 د بار برفوجه به احتمالی بودن آن جزء بارهای خطرناک سازه است و از آنجایی که دربرآوربار برف با ت

ثیر عوامل تا ولذا بار برف هر سازه باید بر اساس شرایط حاکم بر آن سازه  ،عوامل مختلفی تاثیر گذار است

رای تمام بمنطقه آن بار برف توان گفت در یک شهری که . پس میگذار بر مقدار برف آن سازه برآورد گردد

ف آن شهر های مختلد دارد که مقدار بار برف در سازهاین احتمال وجو ؛باشدهای آن شهر یکسان میقسمت

ر ارگذاری بابسبات توان در دفترچه محاها باید تفهیم باشند که نمی، لذا مهندسین طراح سازهمتفاوت باشد

  .برداری کردعه است کپیای که در حال مطالسازه ها را بهبرف سایر سازه

 

 

 

 گروه 

 خطرپذیری
 نوع کاربری ساختمان ها و سایر سازه ها
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 ر سیل.باد.زلزله ویخگروه بندی خطر پذیری ساختمان ها و سایر سازه ها برای با 1-1-6جدول 

 

1 

ه طور غیر بساختمان ها و سایر سازه هایی که به عنوان تاسیسات ضروری طراحی میگردند و وقفه در بهره برداری از آن ها 

نیروگاه ها انگاه ها .مراکز و تاسیسات ابرسانی .مستقیم موجب افزایش تلفات و خسارات میشود مانند بیمارستان ها و درم

به طور  مک رسانی وک.تاسیسلت برق رسانی .برج های مراقبت فرودگاه.مراکز مخابرات .رادیو و تلوزیون .تاسیسات انتظامی . مراکز 

 کلی تمام ساختمان هایی که استفاده از آن ها در امداد و نجات موثر باشد .

ط زیست در ها و تاسیسات صنعتی که خرابی آن ها موجب انتشار گسترده مواد سمی و مضر برای محی ساختمان ها و سایر سازه

قادیری از ب دهنده  مکوتاه مدت یا دراز مدت خواهد گردید . هر گونه ساختمان یا تاسیساتی که سازنده .پردازنده.فروشنده یا ترتی

رای ه به خطری بضوابط قانونی موجود باشند که انتشار این مواد منفجرمواد شیمیایی یا زباله های بسیار خطرناک با توجه به 

 عموم شود.مشمول این گروه خطر پذیری می باشد.

 شند.مورد نیاز می با 1سایر ساختمان ها و سیستم های سازه ای که برای حفظ عملکرد ساختمان های گروه خطر پذیری 

2 

ا. و وم ها .سینممنجر به تلفات جانی قابل توجه شود مانند مدارس.مساجد.استادیساختمان ها وسایر سازه هایی که خرابی آن ها 

 300یش از تئاترها .سالن های اجتماعات .فروشگاه های بزرگ.ترمینال های مسافری یا هر فضای سرپوشیده ی که محل تجمع ب

 نفر زیر یک سقف باشد.

ل توجهی نمی باشند لکن خرابی آن ها خسارت اقتصادی قاب 1 ساختمان ها و سایر سازه های که جز موارد گروه خطر پذیری

مدارک وها اسناد  داشته یا باعث از دست رفتن ثروت ملی می گردد مانند موزه ها .کتابخانه ها .و به طور کلی مراکزی که در آن

 ملی و یا آثار با ارزش نگهداری میشود .

جب آلودگی نمی باشند لیکن خرابی آنها مو 1موارد گروه خطر پذیری ساختمان ها وسایر سازه ها و تاسیسات صنعتی که جزو 

تی که یا تاسیسا محیط زیست و یا آتش سوزی وسیع مانند پالایشگاه ها .مراکز گاز رسانی .انبارهای سوخت .ویا هرگونه ساختمان

زباله های واد شیمیایی خطرناک.سازنده.پردازنده.فروشنده.یا ترتیب دهنده مقادیری از موادی مانند سوخت های خطرناک .م

رای به خطری ب خطرناک ویا مواد منفجره باشند که با توجه به ضوابط قانونی موجود.انتشار گسترده این مواد سمی و مضر منجر

 ( . 3-5-1-6عموم نمیشود )مطابق بند 

3 
اشد مانند گروه خطر پذیری دیگر نب کلیه ساختمان ها و سازه های مشمول این مبحث که جزو ساختمان های عنوان شده در سه

 ...ساختمان های مسکونی .اداری و تجاری .هتل ها.پارکینگ های طبقاتی.انبارها .کارگاه ها ساختمان های صنعتی و

4 

نبارهای اساختمان ها و سایر سازه هایی که خرابی آن ها منجر به تلفات جانی و خسارات مای نسبتا کم خواهد شد مانند 

 سالن های مرغداری . کشاورزی و

 .ساختمان ها و سایر سازه های موقتی که مدت بهره برداری از آنها کمتر از دو سال است 
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 دی خطر پذیری ساختمان ها و سایر سازه ها برای بارهای باد. برف.یخ و زلزلهضریب اهمیت مربوط به گروه بن 1-7-6جدول 

 

 

 Ceی . ضریب برفگیر 2-7-6جدول 

 

 Ctضریب شرایط دمایی .  3-7-6جدول 

 1,0 تمام ساختمان ها به جز موارد زیر 

 1,1 نگهداری میشوند سازه هایی که همیشه در دمای بالاتر از صفر درجه سانتی گراد 

 1,2 سازه هایی با زیر بام باز و سازه های بدون گرمایش 

 1,3 سازه هایی که دمای آنها همیشه زیر صفر درجه سانتی گراد نگهداری میشود 

 

 

 

 گروه خطر پذیری

 1-1-6مطابق جدول 

 ضریب اهمیت

 Ieلرزه ای 

 ضریب اهمیت

 Iwباد بار 

 ضریب اهمیت

 Iiبار یخ 

 ضریب اهمیت

 ISبار برف 

1 1,4 1,25 1,25 1,2 

2 1,2 1,15 1,25 1,1 

3 1 1 1 1 

4 0,8 0,8 0,8 0,8 

 بام برف گیر  بام نیمه برف گیر  بام برف ریز گروه ناهمواری های محیط

 1,2 1,0 0,9 زیاد

 1,1 1,0 0,9 متوسط

 1,0 0,9 0,8 کم
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 هرای کشور از نظر بار برفشتقسیم بندی 1-7-6جدول 

 منطقه شهر ردیف منطقه شهر ردیف

 1 بوشهر 31 5 آستارا 1

 4 بیجار 32 4 اراک 2

 2 بیرجند 33 5 اردبیل 3

 5 پیرانشهر 34 2 ستانارد 4

 4 تبریز 35 4 ارومیه 5

 4 تربت جام 36 4 اسلام آباد غرب 6

 3 تربت حیدریه 37 3 اصفهان 7

 4 تکاب 38 5 الیگودرز 8

 4 تهران جنوب 39 1 امیدیه 9

 4 تهران شمال 40 2 انار 10

 1 جاسک 41 4 اهر 11

 4 جلفا 42 2 اهواز 12

 2 جیرفت 43 1 ایرانشهر 13

 1 چابهار 44 4 ایلام 14

 1 خاش 45 3 ایوان غرب 15

 4 خدابنده 46 2 آبادان 16

 4 خرم آباد 47 3 آباده 17

 4 خرم دره 48 5 آبعلی 18

 5 خلخال 49 5 آستانه اشرفیه 19

 1 خوربیابانک 50 4 انزلی 20

 2 خوربیرجند 51 3 بافت 21

 4 خوی 52 2 بافق 22

 5 داران 53 5 بانه 23

 5 درود 54 4 جنوردب 24

 3 دزفول 55 4 بروجرد 25

 3 دهلران 56 2 بستان 26

 2 دوگنبدان 57 2 بشرویه 27

 4 رامسر 58 2 بم 28

 2 رامهرمز 59 1 بندرعباس 29

 2 رباط پشت بام 60 1 بندر لنگه 30
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 از نظر بار برفای کشور هتقسیم بندی شهر 1-7-6ادامه جدول 
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 منطقه شهر ردیف منطقه شهر ردیف

 3 کاشان 91 5 رشت 61

 2 کاشمر 92 3 رفسنجان 62

 4 کرج 93 4 روانسر 63

 3 کرمان 94 2 زابل 64

 4 کرمانشاه 95 5 زرینه اوباتو 65

 4 کنگاور 96 4 زنجان 66

 1 کهنوج 97 3 سبزوار 67

 6 کوهرنگ 98 4 سراب 68

 3 گرگان 99 1 نسراوا 69

 3 گرمسار 100 3 سرپل ذهاب 70

 5 گلپایگان 101 3 سرخس 71

 4 گلمکان 102 6 سردشت 72

 2 گناباد 103 5 سقز 73

 1 لار 104 3 سمنان 74

 4 ماکو 105 4 سنندج 75

 4 مراغه 106 4 سیرجان 76

 5 مریوان 107 3 شاهرود 77

 3 مسجدسلیمان 108 3 شهربابک 78

 4 مشهد 109 4 شهرکرد 79

 4 ملایر 110 3 شیراز 80

 4 مهاباد 111 2 طبس 81

 4 میانه 112 2 فردوس 82

 2 نائین 113 3 فسا 83

 4 نهاوند 114 4 فیروزکوه 84

 2 نهبندان 115 2 قائن 85

 4 نیشابور 116 4 قراخیل 86

 4 همدان 117 4 قروه 87

 4 همدان نوژه 118 4 قزوین 88

 4 یاسوج 119 3 قم 89

 2 یزد 120 4 قوچان 90
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 .کنیمافزار بصورت زیر عمل میبرای اعمال بارگذاری در نرم

   Define > Load Patternsمسیر: 

 

  : تعریف بارهای ثقلی وارد بر سازه37شکل

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

:ϱтЎмϦ 

Dead: باشد.بار مرده وارد بر سازه می 

Super Dead باشد.: بار مرده نوع دوم در سقفهای مرکب می 

Live:.این بار برای اعمال بار زنده در طبقات می باشد 

Live Roof.این بار برای اعمال بار زنده بام می باشد : 

Live Partition.این بار برای اعمال بار زنده دیوارهای جدا کننده می باشد : 

Re Live باشد.: بار زنده قابل کاهش در سازه می 

Snow.بار برف منطقه برای بام سازه است : 

Wall :گردد.قه بام اعمال  میاین بار برای اصلاح بار لرزه ای سازه در طب 

و بار  1-5-6بار زنده بام بیشترین مقدار بدست آمده از جدول :1نکته

 برف منطقه خواهد بود

در صورتی که بار برف منطقه کمتر از بار زنده بام باشد باز  :2نکته

باید بار برف تعریف گردد. چون در محاسبه وزن لرزه ای بام طبق 

 باید از بار برف استفاده شود. 2800ویرایش چهارم آیین نامه 
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 :)ویرایش چهارم(تعریف بارهای جانبی استاتیکی 5-3

ان به صورت یک نیروی رفت وبرگشتی می باشد.درمدت زممی دانیم که اثرزلزله درسازه  موضوع اول:

ازه سکمتری به آن وارد می شودلذا می توان گفت پس ماهیت بارزلزله یک باردینامیکی است وبایستی 

ت یکی مشکلابادرنظرگرفتن اثرات دینامیکی بارموردتحلیل قرارگیرد.اما ازآنجایی که تحلیل بارهای دینام

ستاتیکی مه هابارزلزله رابه صورت یک باراستاتیکی فرض کرده وازروش های اخاص خودرادارد,لذاآیین نا

 .برای تحلیل سازه هااستفاده می گردد.هرچنداین ساده سازی انجام شده دارای خطاهایی می باشد

ولی مهندسین محترم تا به حال مفاهیمی دررابطه بانمودارتنش کرنش مصالح شنیده اید, موضوع دوم:

ازاین موضوع نداشته ایدلذاخواهشمندیم درادامه بحث به موضوعات فوق دقت شایددرک عمیقی 

 مستمرداشته باشید.

 رفتارغیرخطی مصالح: -1

د,که این باتوجه به نمودارفوق دیده می شودکه رفتارمصالح بعدازنقطه تسلیم وارد مرحله غیرخطی می شو

توان ا میمستهلک نماید، لذ یشتری رانیروهای ب می تواندحله خطی شکل پذیرتربوده و مرحله نسبت به مر

کل شنیروهای زلزله به واسطه  مرحله غیرخطی می شوند گفت درصورتی که درطی یک زلزله مصالح وارد

 شد. پذیری مصالح مستهلک خواهند
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 رفتارغیرخطی هندسی: -2

ن اشاره به آ نیز الاب شکل بارزترین اثرآن که در امالف درسازه می تواند اتفاق بیافتد، به دلایل مخت این رفتار

لنگری  هاکه درپای ستون بارهای جانبی باعث می شود جابجایی گره های صلب دراثر نیمی از می باشد. شد

 گردد. بارهای ثقلی ایجاد ثانویه دراثر

 

ه صورت بقابل نیروهای زلزله م در بخواهیم سازه را براساس موضوع اول ودوم می توان گفت اگر نتیجه:

 ح ونظرگرفتن اثرات غیرخطی مصال در لیل کنیم بایدگفت که بایستی تحلیل دینامیکی باتح تردقیق

های پیشنهاد دیگر از لذا، اما استفاده ازاین روش تحلیل مشکل می باشدغیرخطی هندسی صورت گیرد، 

ی م 2800ه نام آیینبرای انجام تحلیل سازه طبق از این رو  نماییم.نامه برای تحلیل سازه استفاده میآیین

 نیز استفاده کرد.های خطی ان از تحلیلتو

 

 روش های تحلیل خطی  3-2-2

تم سازه روش های مجاز برای تحلیل خطی سازه ساختمان ها با توجه به تعداد طبقات و نوع نامنظمی سیس

 (  تعیین می شود.1-3ای آنها با توجه به جدول  )
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 اختمان هاش های مجاز برای تحلیل خطی س( رو1-3جدول )

 دینامیکی طیفی استاتیکی معادل نوع ساختمان ردیف
دینامیکی تاریخچه 

 زمانی

    کلیه ساختمان ها تا سه طبقه 1

2 
ساختمان های منظم با ارتفاع کمتر از 

 متر از تراز پایه 50
   

3 

ساختمان های نامنظم با ارتفتاع کمتتر 

ا که نامنظمی آنه متر از تراز پایه 50از 

پیچشی یا   پیچشیر پلان از نوع د

و نا منظمتی آنهتا در ارتفتاع از  شدید

،  طبقه نرم،  نامنظمی جرمینوع 

نتتامنظمی و  طبقتته خیلتتی نتترم

 نباشد. هندسی در ارتفاع

   

    سایر ساختمان ها 4
 

 نامنظمی در پلان  1-7-1

ز گوشه اس رفتگی هم زمان در دوجهت در یکی در مواردی که پیش رفتگی یا پنامنظمی هندسی :  -الف

 درصد طول پلان در آن جهت باشد. 20های ساختمان بیشتر از 

بقه ، با در مواردی که حداکثر تغییرمکان نسبی در یک انتهای ساختمان در هر طنامنظمی پیچشی :  -ب

ن طبقه ساختمان در آ دو انتهای تغییرمکان نسبی در درصد متوسط 20احتساب پیچش تصادفی ، بیشتر از 

 باشد.

 پیچشی توصیف می شود. شدیددرصد باشد ، نامنظمی  40در مواردی که این اختلاف بیشتر از 

پیدا می  نامظمی های پیچشی تنها در مواردی که دیافراگم های کف ها صلب و یا نیمه صلب هستند کاربرد

 کند.

جموع سطوح نی در مساحت دیافراگم ، به میزان مدر مواردی که تغییر ناگها نامنظمی در دیافراگم : -پ

درصد  50ر از درصد سطح طبقه و یا تغییر ناگهانی در سختی دیافراگم ، به میزان بیشت 50بازشوی بیشتر از 

 سختی طبقات مجاور وجود داشته باشد.
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عی در در مواردی که در سیستم باربر جانبی انقطا: منظمی خارج از صفحه سیستم باربر جانبینا -ت

 شد .مسیر انتقال نیروی جانبی، مانند تغییر صفحه اجزاء باربر جانبی در طبقات ، وجود داشته با

باربر جانبی به موازات ادر مواردی که سیستم قسیستم های باربر جانبی غیرموازی :  نامنظمی -ث

 محورهای متعامد اصلی ساختمان نبوده و یا نسبت به آنها متقارن نباشد.

 نامنظمی در ارتفاع  -1-7-2

درصد  130قی سیستم باربر جانبی در هر طبقه بیشتر از در مواردی که ابعاد افنامنظمی هندسی :  -الف

 آن در طبقات مجاور باشد.

درصد با جرم های طبقات مجاور تفاوت  50ز در مواردی که جرم هر طبقه بیشتر ا نامنظمی جرمی : -ب

 داشته باشد.

 از این تعریف مستثنی هستند. طبقات بام و خرپشته

در مواردی که اجزای سیستم باربر جانبی در ارتفاع جابجایی درون  بی :نامنظمی سیستم باربر جان -پ

ن روبرو صفحه ای بیشتر از یک دهانه در طبقه داشته باشد و یا با کاهش در سختی جانبی در طبقه زیری

 باشد.

درصد سختی جانبی طبقه  70ر طبقه کمتر از هجانبی در مواردی که سختی  نامنظمی در سختی : -ت

طبقه ای درصد متوسط سختی های جانبی سه طبقه روی خود باشد. چنین  80یا کمتر از  روی خود و

 نامیده می شود.  طبقه نرم اصطلاحا

یلی خحا درصد کاهش پیدا کنند ، طبقه نرم اصطلا 70درصد و  60در مواردی که مقادیر فوق به ترتیب به 

 توصیف می شود. نرم

 

درصد مقاومت جانبی طبقه روی  80مت جانبی طبقه از در مواردی که مقاو نامنظمی در مقاومت : -ث

 نامیده می شود. طبقه ضعیفخود کمتر باشد ، چنین طبقه ای اصطلاحا 

 ه مینامید خیلی ضعیفاصطلاحا  طبقه ضعیفدرصد کاهش یابد  65در مواردی که مقدار فوق به 

 شود.



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̺̿ 
 

در پهنه بندی لرزه  طبقه خیلی ضعیفحداث ساختمان های دارای نامنظمی در ارتفاع از نوع ا -1تبصره 

نند م نمی تواکای با خطر نسبی متوسط و بالاتر ممنوع بوده و این نوع ساختمان ها در مناطق با لرزه خیزی 

 متر ارتفاع داشته باشند. 9طبقه یا  3بیش از 

پیچشی و  طبقه خیلی نرماز نوع  مناطق با خطر لرزه ای متوسط و بالاتر وجود نامنظمیدر  -2تبصره 

 مجاز است .  یا І، Π مین های نوعقط در ساختمان های واقع بر روی زف  شدید

 روش تحلیل استاتیکی معادل 3-3

دادها و تیکی در امتدر این روش نیروی جانبی زلزله بر طبق ضوابط این بند تعیین شده و به صورت استا

عمال می گردد و سازه با فرض رفتار خطی ا، به سازه  5-1-3و  4-1-3جهات مختلف بر طبق بندهای 

 تحلیل می شود.

 vنیروی برشی پایه ،   3-3-1

  ستفاده ازاحداقل نیروی برشی پایه یا مجموع نیروهای جانبی زلزله در هر یک از امتدادهای ساختمان با 

 سبه می گردد :رابطه زیر محا

(3-1                                                        )V = CW 

 در این رابطه :

Vست .تعریف شده ا 2-3-3ین تراز در بند : نیروی برشی در تراز پایه ، ا 

W :رف بر ده و  بادرصدی از بار زنن مؤثر لرزه ای ، شامل تمام بار مرده و وزن تأسیسات ثابت به اضافه وز

ست .بارهای زنده و برف بر طبق مبحث ششم مقررات ملی ساختمان در ا( مشخص شده 2-3که در جدول )

 نظر گرفته می شود.

C: ضریب زلزله که از رابطه زیر به دست می آید : 

                                                                               
ABI

Ru
=  C 

 ر آن :که د

A   شتاب زلزله به شتاب ثقل( نسبت شتاب مبنای طرحg موضوع بند )2-2 
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B 3-2: ضریب بازتاب ساختمان موضوع بند 

I  4-3-3ضریب اهمیت ساختمان موضوع بند 

uR5-3-3اختمان موضوع بند سرفتار  : ضریب 

̹-̹ 

 

 Aنسبت شتاب مبنای طرح ،  2-2

( 1-2ف کشور ، بر اساس خطر لرزه خیزی آنها ، به شرح جدول )نسبت شتاب مبنای طرح در مناطق مختل

 ( مشخص شده است .1مناطق چهارگانه عنوان شده در این جدول در پیوست )تعیین می شود. 

 

 ( : نسبت شتاب مبنای طرح در مناطق با لرزه خیزی مختلف1-2جدول)        

 نسبت شتاب مبنای طرح توصیف منطقه

1 

2 

3 

4 

 نسبی خیلی زیاد پهنه با خطر

 پهنه با خطر نسبی زیاد

 پهنه با خطر نسبی متوسط

 پهنه با خطر نسبی کم

35/0 

30/0 

25/0 

20/0 

  

 

 Bضریب بازتاب ساختمان ،  2-3

 مفهوم ضریب بازتاب سازه: 

حرکت خواهدکرد واین شتاب ازلابه لای خاک های بالای  شتاب بادرهنگام وقوع زمین لرزه سنگ بستر 

جانب زمین لرزه  کردن نیروی اعمالی درسازه از بنابراین درپیدا رسد.به سازه می عبورکرده و سنگ بستر

نحوه انتقال شتاب سنگ  پس می توان گفت خاک نقش اساسی در شتاب انتقال یافته به سازه اهمیت دارد. 

به نوع خاک  است بنابراین زمین بازتاب که نسبت شتاب سازه به شتاب سنگ بستر بستربه سازه دارد.

 (Aشتاب مبنای طرح)

 (Bضریب بازتاب)
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چون همچنان که گفته شد خاک ساختگاه درنحوه انتقال شتاب ازسنگ بستربه سازه  ساختگاه وابسته است.

 نقش بسزایی داردکه می تواندباعث تشدیدیااستهلاک شتاب انتقالی به سازه باشد.

 نتیجه شتاب سازه: در روی ضریب بازتاب ساختمان و در مهم ترین عوامل تاثیرگذار

 امواج زلزله برای رسیدن به سازه بایدازلایه های خاک عبورکنندکه براساس :کنوع خا -1

 مشخصات ومفاهیم ژئوتکنیک لرزه ای ویژگی های موجوددرخاک می تواندشتاب انتقالی به

 سازه رانسبت به شتاب بسترسنگی تغییردهد.

ثال عنوان م سختی سازه برروی نحوه ارتعاش وشتاب سازه اثرگذاراست. به :ویژگی های سازه -2

ند.که ساختمان های کوتاه زمان تناوب بیشتری درنوسان دار درمقایسه با ساختمان های بلند

 باشد. هان سازهشتاب ای تفاوت در و باعث تغییر این موضوع می تواند

محیط های ساخت های موجوددرکشورکه در خاک2800 آیین نامه ازنظر طبقه بندی انواع خاک:

ای ه گونهب هاتقسیم بندی شوند.دسته تقسیم می4به اصطلاح ساختگاه شناخته شده اندوسازوجودارد که به 

 ای ازسرعت موج برشی خاک تعریف شده است.نوع خاک برای محدوده است که هر

 

یر ز رابطه زضریب بازتاب ساختمان بیانگر نحوه پاسخ ساختمان به حرکت زمین است. این ضریب با استفاده ا

 : تعیین می ئشود

   (1-2          )                                                                                          N1B=  B

 ضریب اصلاح طیف است. N ضریب شکل طیف و  1B در رابطه بالا 

زان لرزه گ نمایی خاک در پریودهای مختلف و میر، با در نظرگرفتن بز 1B ضریب شکل طیف ،  1-3-2

ب  -1الف و  -1خیزی منطقه مشخص می شود. این ضریب با استفاده از روابط زیر و یا از روی شکل های 

 تعیین می شود.
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B1 = S0 + (S ï S0 +1)(T/T0)          0<T<T0 

B1 = S + 1                                      T0<T<TS                                         )2-2( 

B1 = (S +1)(TS/T)                             T>TS 

 در این روابط :

T ود.تعیین می ش 3-3-3: زمان تناوب اصلی نوسان ساختمان به ثانیه است . این زمان طبق بند 

0T ,ST ,S ,0Sند. مقادیر ا : پارامترهایی هستند که به نوع زمین و میزان خطر لرزه خیزی منطقه وابسته

 مشخص شده اند. 4-2( و انواع زمین ها در بند 2-2این پارامترها در جدول )

 

 

 (2-2( : پارامترهای مربوط به روابط )2-2جدول )

 0T ST نوع زمین
 خطر نسبی زیاد و خیلی زیاد خطر نسبی کم و متوسط

S 0S S 0S 
 1/0 4/0 5/1 1 5/1 1 

 1/0 5/0 5/1 1 5/1 1 

 15/0 7/0 75/1 1/1 75/1 1/1 

V 15/0 0/1 25/2 3/1 75/1 1/1 

 

 شود:به شرح یزر تعیین می ، N، ب اصلاح طیفضری 2-3-2

  :(N)ضریب اصلاح طیف

سبت نباتوجه به تقسیم بندی ناحیه های دورازگسل ونزدیک گسل ثابت می شودکه حوزه های نزدیک گسل 

ه حوزه ببرخوردارند.لذاپاسخ سازه های نزدیک گسل نسبت به حوزه های دورازگسل ازآسیب پذیری بیشتری 

 دورازگسل بیشترخواهدبود.
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انه تری توان گفت سازه ای که درحوزه نزدیک گسل واقع شده است بایستی ازشرایط سخت گیرازاین رو می

مان ابازهدهدکه درحوزه نزدیک گسل نیزسازه مطالعات نشان می باشد. نسبت به حوزه دورازگسل برخوردار

ازاین  .تناوب بیشتر )سازه های بلندتر(درحوزه نزدیک گسل نسبت به سازه های کوتاه ترآسیب پذیرترند

نزدیک  برای حوزه های Nی ضریبی بنامبوسیله بازتاب را  مقدارضریب 4ویرایش نیزدر2800روآیین نامه

یشتری ی ضریب بازتاب باعمال این ضریب سازه های نزدیک گسل دارا درحقیقت با گسل اصلاح کرده است.

اشیم باهی ازحوزه نزدیک داشته بصیرت وآگ بخواهیم  اگر داشت. نسبت به سازه های دورازگسل خواهند

ونه است توانیم بگوییم که درحوزه نزدیک گسل نوعی نیروی اعمال به سازه ازطرف زمین لرزه ضربه گمی

 از ملاسب درمقابل زلزله خواهدداشت.پس عسازه دراین حالت فرصت کمتری برای نشان دادن پاسخ منا پس

روی می باشند)نیروی لختی,نیروی میرایی,نی سازه که عامل ایستایی سازه ها های مقاومتیپتانسیل

 بود. آسیب پذیری خواهدعد وسازه مست شد فنر,کرنش(کاسته خواهد

 

 برای پهنه های با خطر نسبی خیلی زیاد و زیاد الف( 

N = 1                                     T<TS  

N = 
0.7

4 -TS
 (T ï TS) +1           TS<T<4sec                                                                        )2-3( 

N = 1.7                                 T<4sec 

 

 

 الف( برای پهنه های با خطر نسبی متوسط و کم 

N = 1                                     T<TS  

N = 
0.4

4 -TS
 (T ï TS) +1           TS<T<4sec                                                                        )2-4( 

N = 1.4                                T<4sec 
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نسبی متوسط و کم به میزان هستاد درصد رابطه ، برای پهنه های با خطر   Nضریب اصلاح طیف ،  2-3-3

 ود.ش( تعیین می 2-2( و یا شکل )2-4)

 

 

 

 Tزمان تناوب اصلی نوسان ،  3-3-3

ی زیر وابط تجربرزمان تناوب اصلی نوسان بسته به مشخصات ساختمان و ارتفاع آن از تراز پایه با استفاده از 

 تعیین می گردد.

 یستم قاب خمشی برای ساختمان های با س الف 

 نانچه جداگرهای میانقابی مانعی برای حرکت قاب ها ایجاد ننمایند :چ -1

 های فولادی :ب در قا  -

T = 0/08H3/4                                                     )3-3(          

  در قاب های بتن مسلح :  -

T = H                )3-4(  

 جداگرهای میانقابی مانعی برای حرکت قاب ها ایجاد نمایند : چنانچه-2

 درصد مقادیر عنوان شده در بالا در نظر گرفته می شوند. 80برابر با   Tمقدار 

 (Tزمان تناوب)
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 های دارای مهاربندهای واگرا ،  در قاب -ب

T = 0/08H 3/4 )3-5(  

ر از سیستم کنسولی ، در تمام موارد ( ، به غی5-3رای سایر سیستم های ساختمانی مندرج در جدول )ب -ج

 وجود و یا عدم وجود جداگرهای میانقابی

T =0/05 H                                                      )3-6( 

اع خرپشته ، ، ارتفاع ساختمان بر حسب متر ، از تراز پایه است و در محاسبه آن ارتف  Hدر روابط فوق ، 

 Hشیب دار ، درصد وزن بام باشد ، نیز باید منظور گردد. درمورد بام های 25بیشتر از  درصورتیکه وزن آن

 بر اساس ارتفاع متوسط بام از تراز پایه محاسبه می شود.

 :پایهتراز

مبنا  رازت از ترحرکت قسمت های پایین لذا شودمی به سازه وارد آن تراز ترازی است که نیروی زلزله از

 یافته و زه انتقاله صلب خواهدبود.بنابراین می توان گفت نیروی زلزله ازروی ترازمبنابه سادربرابرنیروی زلزل

ردبررسی بایستی حرکت جانبی سازه مو مبنا ارتفاع سازه پخش می شود بنابراین برای پیداکردن تراز در

 تعیین گردد. مبنا تراز قسمت منعطف وصلب سازه مشخص شده و تا قرارگیرد

که سازه برروی فونداسیون قرارداردحرکت انعطافی سازه ازبالای فونداسیون شروع دراکثرحالاتی 

خواهدشد.یعنی قسمت بالایی فونداسیون منعطف وازآن ترازبه پایین حرکت صلب خواهدداشت. لذادرچنین 

زسازه حالاتی ترازمبناروی فونداسیون خواهدبود. درصورتی که درسازه ای مقداری ازارتفاع بالای فونداسیون ا

فونداسیون  این قسمت حرکت صلب ویکنواختی با شده باشد بتنی دراطراف سازه مقعید به وسیله دیوار

یک  در شد. به عنوان مثال اگر به بالای این ارتفاع محدود خواهد مبنا درچنین مواقعی تراز لذا داشت. خواهد

 مبنا بالای طبقه دوم و تراز رشی باشدبه صورت پیوسته دیوارب طبقه اول پیرامون خود2 طبقه در 8  یسازه

 بود. ابتدای طبقه سوم خواهد
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 :مفهوم میان قاب

یان قاب هرعاملی که مانعی درمقابل حرکت قاب باشدمیان قاب خواهدبود. درسازه های ساختمانی اکثرام 

شود.  هادیوارهای داخل قاب هستند. میان قاب هادرصورت اتصال قاب باعث افزایش سختی جانبی قاب می

ن های درصورتی که بخواهیم دیوارهامانع حرکت نشوندیا اصطلاحا میان قاب محسوب نشوندبایستی ازستو

 اطراف خودمقداری فاصله داشته باشند.

  :فاصله مابین دیوارستون وقاب

 .بقه باشدطفاصله دیواروقاب برای اینکه دیوارمانع حرکت قاب نشودبایستی برابربا حداکثرجابجایی نسبی 

 ته:نک

 بطراحی قا بایستی در 2800طبق آیین نامه درصورتی که دیوارمانع حرکت قاب شود)میان قاب باشد(

 مشکل است. درنظرگرفته شود که این کار قاب)اثرقاب ودیواربرروی هم( و بین دیوار اندرکنش ما

را با  ،Tان، بجای استفاده از روابط تجربی یاد شده می توان زمان تناوب اصلی نوسان ساختم :1تبصره

 25/1اید از استفاده از روش تحلیل مناسب با در نظر گرفتن خصوصیات سازه محاسبه نمود، ولی مقدار ان نب

 برابر زمان تناوب به دست آمده از رابطه تجربی بیشتر اختیار شود. 

تفاوت تمان های متعارف مآنها با ساخ : در مورد ساختمان های خاصی که ویژگی های دینامیکی 2تبصره

، باید با  Tمحل تردید باشد ، زمان تناوب اصلی نوسان ساختمان ،  5-3الی  3-3نتای  روابط تجربی بوده و 

استفاده از روش تحلیلی مناسب و با در نظر گرفتن اثرات کلیه اجزای سازه ای و اجزای غیرسازه ای 

ت اجزای غیرسازه ای در مدل تحلیلی تأثیرگذار از قبیل جداگرهای میانقابی محاسبه شود، درصورتیکه اثرا
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درصد زمان تناوب تحلیلی در نظر  80، را باید Tدرنظر گرفته نشود ، زمان تناوب اصلی نوسان ساختمان ،

 گرفت.

مان تناوب اصلی سازه های بتنی ، بمنظور در نظر گرفتن سختی مؤثر در اثر ترک در محاسبه ز -3تبصره

 Igوارها و برای ستون ها و دی Ig  5/0ی مقاطع قطعات برای تیرها خوردگی بتن ، لازم است ممان اینرس

بر مقادیر برا 5/1ممان اینرسی مقطع کل عضو بدون درنظر گرفتن فولاد است. این مقادیر  Igمنظور شود. 

 برای مقاطع ترک خورده است. 5-6-3مندرج در بند 

 نکته:

هنگام  در لذا؛ مشخص گردد سختی اولیه سازه ت تازمان تناوب تجربی گفته شده برای تحلیل اولیه سازه اس

زمان تناوب واقعی سازه براساس  زمان تناوب واقعی استفاده شود. بایستی از هاطراحی سازه

  بود. بصورت زیرخواهد2800استاندارد

 زمان تناوب تجربی. یا زمان تناوب تحلیلیmin{1.25}زمان تناوب واقعی سازه=

 .بدست می آید sap  یا  etabs  لیل واقعی دینامیکی سازه به وسیلهتح : اززمان تناوب تحلیلی
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 I ، ضریب اهمیت ساختمان 3-3-4

( تعیین 4-3ول )، مطابق جد 6-1ضریب اهمیت ساختمان با توجه به گروه طبقه بندی آنها ، به شرح بند  

 می گردد:

  

 ( ضریب اهمیت ساختمان4-3جدول )

 میتضریب اه طبقه بندی ساختمان

 1گروه 

 2گروه 

 3گروه 

 4گروه 

4/1 

3/1 

0/1 

8/0 

 

 

 

 uRضریب رفتار ساختمان ،  5-3-3

ز قبیل شکل پذیری ، درجه نامعینی و اضافه مقاومت ربرگیرنده عواملی اساختمان د ضریب رفتار 3-3-5-1

ای بند  ودیت هموجود در سازه است. این ضریب  با  توجه  به نوع سیستم باربر ساختمان که در آن  محد

در این جدول  uRعیین می گردد. مقادیر ت( 3-5اشد طبق جدول )برعایت شده  3-5-9-3و  3-3-8-5

اساس  برای سازه هایی که  بر اساس مقاومت طراح می شوند ، تنظیم شده است. برای سازه هایی که بر

رکیب کاهشی ضرب شود. ت روش تنش های مجاز طراحی می شوند مقدار نیروی جانبی زلزله باید در ضریب

 دارد انجام شود. این استان 13-3نیروهای زلزله با سایر بارها در روش های مختلف باید بر اساس ضوابط بند 

مجاز در کلیه مناطق کشور  (3-5در جدول ) mHساخت ساختمان های با ارتفاع بیشتر از حدود  3-3-2-5

می میته دائ، تأیید ک بیشتر از این حدود مد نظر باشد نیست. برای ساختمان های خاص که در آنها ارتفاعی

 این آیین نامه الزامی است  .

 (Iضریب اهمیت)

 (uRضریب رفتار )
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فقط باید از  «خیلی زیاد » ا خطر نسبی خیلی زیاد برای ساختمان های با اهمیت در مناطق ب 3-3-5-3

 دارند انتخاب شود. «ویژه»سیستم هایی که عنوان 

متر ، استفاده از سیستم قاب خمشی  50و یا بلندتر از طبقه  15های با بیش از  در ساختمان 3-3-5-4

زلزله  روی جانبیویژه و یا سیستم دوگانه الزامی است. در این ساختمان ها نمی توان برای مقابله با تمام نی

 منحصرا به دیوارهای برشی و یا قاب های مهاربندی شده اکتفا نمود. 

های یستم قاب خمشی منحصرا در ساختمانبه عنوان ساستفاده از دال تخت یا قارچی و ستون  3-3-5-5

استفاده از این  متر مجاز می باشد. در صورت تجاوز از این حد ، تنها در صورتی 10سه طبقه و یا کوتاهتر از 

هاربندی سیستم سازه مجاز است که مقابله با نیروی جانبی زلزله توسط دیوارهای برشی و یا قاب های م

 شده  تأمین گردد.

ش سقف ها استفاده لوک برای پوشنها ار سیستم تیرچه بآدر ساختمان های بتن مسلح که در  3-3-5-6

 30کمتر از  شود ، در صورتی که ارتفاع تیرهابرابر ضخامت سقف درنظر گرفته می گردد و ارتفاع تیرهامی

می  5-5-3-3سانتیمتر باشد ، سیستم سقف به منزله دال تخت محسوب شده و ساختمان مشمول بند 

 شود.

سازمان مدیریت و  324لادی دارای اتصالات خورجینی ساده بر طبق نشریه شماره قاب های فو 3-3-5-7

اب ی گیرند.قبرنامه ریزی همراه با دیوار برشی یا مهاربندی ، در گروه سیستم قاب ساختمانی ساده قرار م

ط نشریه ، قاب خمشی فولادی متوس های فولادی دارای اتصالات خورجینی گیردار بر طبق ضوابط آن

ن دارای ای محسوب می شوند ، لیکن حداکثر ارتفاع مجاز ساختمان هایی که در آنها تنها از قاب های خمشی

 متر تقلیل می یابد. 30نوع اتصالات استفاده می شود به 

 م ها در پلانترکیب سیست 3-3-5-8

ده لان استفاای تحمل بار جانبی ، در دو امتداد در پدر ساختمان هایی که از دو سیستم سازه ای مختلف بر

 ته شود.مربوط به آن سیستم در نظر گرف 0و  dCشده باشد ، برای هر سیستم باید ضریب رفتار وضرایب 

ر ب رفتار دتنها در مواردی که در یک امتداد از سیستم دیوارهای باربر استفاده شده باشد ، مقادیر ضری

 شتر از مقدار آن در امتداد سیستم دیوارهای باربر اختیار گردد.امتداد دیگر نباید بی
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 م ها در ارتفاعترکیب سیست 3-3-5-9

ر سازه ای مختلف برای تحمل بار جانبی د ، از دو سیستم 8-4-1در ساختمان هایی که علیرغم توصیه بند 

( 1ش )از دو رو ی زلزله باید یکییک امتداد در ارتفاع ساختمان استفاده شده باشد ، برای تعیین نیروی جانب

 ( زیر مورد استفاده قرار گیرد :2یا )

ری سیستم های مختلف سازه ای در امتدادهای مختلف در پلان و در ارتفاع حتی از بکارگی 1-5-10

 االمقدور خودداری شود. 

 

باید رعایت شود و  ، با منظور کردن ارتفاع کل سازه 3-3-3( برای تعیین زمان تناوب کل سازه ضابطه بند 1

 -ه دست میبکار برده شده رای دو سیستم بدر آن از رابطه تجربی که کمترین مقدار زمان تناوب اصلی را ب

 دهد، استفاده گردد. محاسبات نیروی جانبی برای قسمت های مختلف به شرح زیر انجام می شود:

نی است ، مقدار آن برای سیستم فوقا الف( در حالتی که ضریب رفتار برای سیستم قسمت تحتانی بیشتر از

 قسمت فوقانی برای محاسبات هر دو قسمت مورد استفاده قرار می گیرد.0و  uRCdمقادیر 

 انیاز مقدار آن برای سیستم قسمت فوق ب(در حالتی که ضریب رفتار برای سیستم قسمت تحتانی کمتر

 ر گیرد.این قسمت می تواند مورد استفاده قراقسمت فوقانی برای محاسبات 0و  uR Cdدیر، مقا است

ده اید مورد استفامربوط به همین سیستم ب0و  uRCdلیکن برای محاسبات قسمت تحتانی مقادیر 

 ɟ/uRدر این حالت نیروهای عکس العمل ناشی از تحلیل قسمت فوقانی نیز که در نسبت  قرار گیرد.

. این ه اند، باید به مدل سازه قسمت تحتانی اعمال شودقسمت تحتانی ضرب شد  ɟ/uRقسمت فوقانی به 

 نسبت در هر حال نباید کوچکتر از یک باشد.

تی جانبی ( برای ساختمان هایی که سختی جانبی قسمت فوقانی آنها به طور قابل ملاحظه ای کمتر از سخ2

نجام رحله ای ادو مبه صورت  قسمت تحتانی بوده و شرایط الف و ب زیر را نیز دارا باشند، می توان تحلیل را

 داد.

 الف( سختی متوسط طبقات تحتانی حداقل ده برابر سختی متوسط طبقات فوقانی باشد.

حالتی که  برابر زمان تناوب اصلی قسمت فوقانی ، در 1/1ب( زمان تناوب اصلی نوسان کل سازه بیشتر از 

 باشد ، نباشد.این قسمت به صورت یک سازه جداگانه با پای گیردار فرض  شده 
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 ی جانبی به شرح زیر انجام می شود:ارای شرایط فوق باشندمحاسبات نیرودر ساختمان هایی که د

نبی نیروی جا والف( سازه انعطاف پذیر قسمت فوقانی به طور مجزا و با تکیه گاه گیردار در نظر گرفته شده 

ن همی 0ɋو  dCی گردد. مقادیر مربوط به این قسمت محاسبه م و  uRآن با در منظور کردن ضرایب 

 قسمت نیز در محاسبات منظور می شود.

رایب ضب( سازه سخت قسمت تحتانی به طور مجزا در نظر گرفته شده و نیروی جانبی آن با منظور کردن 

uR  وقانی مربوط به این قسمت محاسبه می گردد. ضمنا نیروهای عکس العمل ناشی از تحلیل قسمت ف و

ه قسمت تحتانی ضرب شده اند ، باید به مدل ساز  ɟ/uR قسمت فوقانی به  ɟ/uR نیز که در نسبت

  0و  Cdشود. این نسبت در هر حال نباید کوچکتر از یک باشد. ضمنا مقادیر قسمت تحتانی اعمال 

 همین قسمت نیز در محاسبات مربوطه منظور می شود.

uR 0 Cd mH سیستم مقاوم در برابر نیروهای جانبی سیستم سازه

 

 یستم دیوارهای باربرس-الف

 رشی بتن مسلح ویژهبیوارهای -1

 رهای برشی بتن مسلح متوسطدیوا-2

 [1یوارهای برشی بتن مسلح معمولی]د-3

 یوارهای برشی با مصالح بنایی مسلحد-4

 یوار متشکل از قاب سبک فولادی سرد نورد و مهار تسمه ای فولادید-5

 بک فولادی سرد نورد و صفحات پوشش فولادیاب سدیوار متشکل از ق -6

 بتن پاششی سه بعدی دیوارهای-7

5 

4 

5/3 

3 

4 

5/5 

3 

5/2 

5/2 

5/2 

5/2 

2 

3 

2 

5 

4 

5/3 

3 

5/3 

4 

3 

50 

50 

- 

15 

15 

15 

10 

 یستم قاب ساختمانیس-ب

 [2ارهای برشی بتن مسلح ویژه]یو-1

 رهای برشی بتن مسلح متوسطدیوا-2

 [1معمولی]بتن مسلح  دیوارهای برشی-3

 یوارهای برشی با مصالح بنایی مسلحد-4

 [3[ و ]2هاربندی واگرای ویژه فولادی ]م-5

 مهاربندی کمانش تاب-6

 [2فولادی ] معمویمهاربندی همگرای   -7

 [2مهاربندی همگرای ویژه فولادی ]-8

6 

5 

4 

3 

7 

7 

5/3 

5/5 

5/2 

5/2 

5/2 

5/2 

2 

2 

2 

2 

5 

4 

3 

5/2 

4 

5/5 

5/3 

5 

50 

50 

- 

15 

50 

50 

15 

50 

 200 5/5 3 5/7 [4بتن مسلح ویژه ] قاب خمشی-1 یستم قاب خمشیس-پ
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   mH ، همراه با حداکثر ارتفاع مجاز ساختمان uRیر ضریب رفتار ساختمان ، ( مقاد3-5جدول )

 

 

 : رابطه زیر درنظر گرفته شود ، در هیچ حالت نباید کمتر از مقدار داده شده در vپایه ،  برش

Vmin =  AIW                        -  

 ( درصد میزان مشارکت بار زنده و بار برف در محاسبه نیروی جانبی زلزله2-3جدول )

 درصد میزان بار زنده محل بار زنده

 20 بام های ساختمان ها در مناطق با برف زیاد ، سنگین و فوق سنگین

 - ساختمان ها در سایر مناطقبام های 

 20 ساختمان های مسکونی ، اداری ، هتل ها و پارکینگ ها

 20 حامبیمارستان ها،مدارس ، فروشگاه ها ، ساختمان های محل اجتماع یا ازد

 40حداقل  کتابخانه ها و انبارها )با توجه به نوع کاربری(

 100 مخازن آب و یا سایر مایعات

  

ɟنامعینی سازه  ضریب و 3-3-1-1

 [4شی بتن مسلح متوسط ]قاب خم-2

 [1[ و ]4اب خمشی بتن مسلح معمولی ]ق-3

 هقاب خمشی فولادی ویژ-4

 توسطقاب خمشی فولادی م-5

 [5[ و ]1اب خمشی فولادی معمولی ]ق-6

5 

3 

5/7 

5 

5/3 

3 

3 

3 

3 

3 

5/4 

5/2 

5/5 

4 

3 

50 

- 

200 

50 

- 

یستم دوگانه یا س-ت

 ترکیبی

 اب خمشی ویژه)فولادی یا بتنی(، دیوارهای برشی بتن مسلح ویژهق-1

 اب خمشی بتن متوسط+دیوار برشی بتن مسلح ویژهق-2

 اب خمشی بتن متوسط+دیوار برشی بتن مسلح متوسطق-3

 اب خمشی فولادی متوسط+دیوار برشی بتن مسلح متوسطق-4

 دیمشی فولادی ویژه+ پمهاربندی واگرای ویژه فولاقاب خ-5

 اب خمشی فولادی متوسط +مهاربندی واگرای ویژه فولادیق-6

 اب خمشی فولادی ویژه+مهاربندی همگرای ویژه فولادیق-7

 اب خمشی فولادی متوسط+مهاربندی همگرای ویژه فولادیق-8

5/7 

5/6 

6 

6 

5/7 

6 

7 

6 

5/2 

5/2 

5/2 

5/2 

5/2 

5/2 

5/2 

5/2 

5/5 

5 

5/4 

5/4 

4 

5 

5/5 

5 

200 

70 

50 

50 

200 

70 

200 

70 

 10 2 5/1 2 های فولادی یا بتنی ویژه سازه-1 تم کنسولیسیس-ث
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یه در هر یک از متر از تراز پایه ، نیروی برشی پا 10طبقه یا ارتفاع  3در ساختمان های با ارتفاع بیش از 

ریب مربوط مربوط به آن امتداد ضرب شود.این ض امتدادهای اصلی ساختمان باید در ضریب نامعینی 

کی از شرایط می باشد. درصورت اقناع ی 2/1ابردرصورتیکه شرایط بندهای الف یا ب زیر اقناع نشده باشد بر

 اختیار می شود. 1زیر ضریب مذکور برابر 

 ایه ساختماننیروی برشی پ %35ساختمان منظم در پلان بوده و در طبقاتی که نیروی برشی بیش از  -الف

جرم کز جانبی در هر طرف مردر آن ها ایجاد می شود، دارای حداقل دو دهانه مقاوم در برابر بارهای 

سیم ها از تق تداد اصلی ساختمان باشند. در سیستم های دارای دیوار برشی تعداد دهانهساختمان و در هر ام

  طول دیوار بر دو سوم ارتفاع طبقه به دست می آید.

وجه به نوع نیروی برشی پایه ایجاد شود ، باید با ت %35هر طبقه ای از ساختمان که در آن بیش از  -ب

 را باشد.( را دا3-3ای ضوابط جدول )سیستم سازه 

نیروی برش پایه در طبقه ای از  %35برای مواردی که بیش از  1برابر  ( ضوابط استفاده از 3-3جدول )

 ساختمان ایجاد می شود

 ضوابط نوع سیستم مقاوم در برابر نیروهای جانبی

 قاب ساده مهار بندی شده

ست رفتن بیش از حذف یک مهاربند یا اتصال آن منجر به از د

مقاومت برشی طبقه نشود و ضمنا باعث ایجاد نامنظمی  33%

 نگردد. 1-7-1شدید پیچشی در پلان مذکور در بند 

 قاب خمشی

از دست رفتن مقاومت خمشی در اتصالات دو انتهای یک تیر 

مقاومت برشی طبقه نشود  %33منجر به از دست رفتن بیش از 

د پیچشی در پلان مذکور در و ضمنا باعث ایجاد نامنظمی شدی

 نگردد. 1-7-1بند 

 دیوار برشی

حذف یک دهانه دیوار برشی منجر به از دست رفتن بیش از 

مقاومت برشی طبقه نشود و ضمنا باعث ایجاد نامنظمی  33%

 نگردد. 1-7-1شدید پیچشی در پلان مذکور در بند 

 

ر د 1نی برابر برابر نیروهای جانبی ، ضریب نامعیدر ساختمان های دارای سیستم دوگانه مقاوم در  :1تبصره 

 نظر گرفته می شود.
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 ته می شود.در نظر گرف 1: در محاسبات مربوط به تغییر مکان نسبی طبقات ، ضریب نامعینی برابر  2تبصره

 توزیع نیروی جانبی زلزله در ارتفاع ساختمان 3-3-6

است ، مطابق رابطه زیر در ارتفاع ساختمان توزیع  محاسبه شده 1-3-3، که طبق بند   Vنیروی برشی پایه 

 می گردد :

Fi = 
Wihi

k

∑ Wjhjkn
j=1

 V                                 )3-6( 

iF نیروی جانبی در تراز طبقهi 

iW :   طبقه وزنi ( و نصف وزن3-2شامل وزن سقف و قسمتی از سربار آن مطابق جدول ) دیوارها و 

 ستونهایی که در بالا و پایین سقف قرار گرفته اند.

 ih   ارتفاع تراز :i  ارتفاع سقف ،i از تراز پایه ، 

n  تعداد طبقات ساختمان از تراز پایه به بالا : 

k  75/0: برابر  +T 5/0   و برای  1برابر  ثانیه 5/0، این عدد برای سازه های با زمان تناوب اصلی کمتر از

ه همان زمان در این رابط Tانتخاب می شود.  2ثانیه برابر  5/2ا زمان تناوب اصلی بزرگتر از سازه های ب

فاده قرار مورد است Bمحاسبه شده و در تعیین ضریب  3-3-3تناوب اصلی سازه  است که بر طبق بند 

 گرفته است.

ک طبقه یبه عنوان  پشتهخردرصدوزن بام باشد ،  25تبصره : در صورتیکه وزن خرپشته ساختمان بیشتر از 

 مستقل محسوب می شود. در غیر اینصورت خرپشته به عنوان بخشی از بام در نظر گرفته می شود.

 توزیع نیروی برشی زلزله در پلان ساختمان 3-3-7

، در طبقات ساختمان ایجاد می  6-3-3نیروی برشی زلزله ، که بر اساس توزیع نیروها در بند  3-3-7-1

نیروی برشی ناشی از پیچش ایجاد شده به علت برون از مرکز بودن این نیروها در طبقات باید شود به همراه 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̀̀ 
 

، در هر طبقه بین عناصر مختلف سیستم مقاوم در برابر نیروهای جانبی به تناسب  2-7-3-3، طبق بند 

غییرشکل های سختی آنها توزیع گردد. در صورت صلب نبودن کف طبقات ، در توزیع این برش ها باید اثر ت

 ایجاد شده در کف ها نیز منظور گردد.

 ید:آ، در اثر نیروهای جانبی زلزله ، از رابطه زیر به دست می  iایجاد شده در طبقه  لنگر پیچشی 3-3-7-2

Mi = ∑ ( eij+ eaj) Fj 

 در این رابطه :

ije  برون مرکزی نیروی جانبی طبقه :j  نسبت به مرکز سختی طبقهi بقه له افقی مرکز جرم ط، فاصj  و

 iمرکز سختی طبقه 

aje برون مرکزی اتفاقی طبقه : j   ود.شمحاسبه می  3-7-3-3، این برون مرکزی طبق ضابطه بند 

jF  نیروی جانبی در تراز طبقه :j 

 شوند. کلیه عناصر سازه باید برای لنگر پیچشی که بیشترین تلاش را در آنها ایجاد می کند ، طراحی

به منظور به حساب آوردن احتمال تغییرات اتفاقی ،  ajeبرون مرکزی اتفاقی در تراز هر طبقه ،  3-7-3-3

 .ته می شودتوزیع جرم و سختی از یک سو و نیروی ناشی از مولفه پیچشی زلزله از سوی دیگر ، در نظر گرف

امتداد عمود  ر آن طبقه ، دردرصد بعد ساختمان د 5این برون مرکزی باید در هر دو جهت و حداقل برابر با 

ب(  -1-7-1بر نیروی جانبی ، اختیار شود. در مواردی که ساختمان مشمول نامنظمی پیچشی موضوع بند )

 ضرب شود.طبق رابطه زیر ،  jA می شود، برون مرکزی اتفاقی حداقل باید در ضریب بزگنمایی

 در این رابطه :

Aj = (
∆max

/ ∆ave
)2                             1  Aj Ò  

maxحداکثر تغییر مکان طبقهj 

 aveæ میانگین تغییر مکان دو انتهای ساختمان در طبقهj 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̷̷ 
 

طبقه و یا کوتاهتر از هیجده متر در مواردی که برون مرکزی نیروی  5های تا  در ساختمان 3-3-7-4

د عمود بر ختمان در آن طبقه در امتدادرصد بعد سا 5جانبی طبقه در طبقات بالاتر از هر طبقه کمتر از 

طبقات  نیروی جانبی باشد ، برای محاسبات لنگر پیچشی نیازی به در نظرگرفتن برون مرکزی اتفاقی در

 نیست.

 

 

  Define > Load Patternsمسیر: 

 

 تعریف بارهای جانبی استاتیکی در نرم افزار

X Direction 

Y Direction 
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  : تعریف بارهای جانبی وارد بر سازه38شکل

 نحوه اعمال پیچش تصادفی 3-4-1

  Define > Load Patternsمسیر: 

 

 

 

Exp 

ExN 
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  X: تعریف پیچش تصادفی در راستای 39شکل

 

 

 

 Y: تعریف پیچش تصادفی در راستای 40شکل

ار افزرا همزمان تعریف کرد. چون در اینصورت نرم EXNوEXEXPتوان می Etabs 2013در نکته: 

یلی کاهش خرت تعداد ترکیب بارها هم در اینصو کند.بارها را تفکیک کرده و جداگانه به سازه اعمال می

 یابد.می
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 X: تعریف بارهای جانبی بصورت یکجا برای راستای 41شکل
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 Y: تعریف بارهای جانبی بصورت یکجا برای راستای 42شکل

 

 

 

 بار قائم زلزله  3-4-2

 

 : تعریف بار قائم زلزله43شکل

 .آورده شده است در ادامه 2800نامه بر اساس ضوابط آیینر ترکیبات بار نحوه اعمال بار قائم زلزله دنکته: 

3-4-3  National Load 
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ن باید همچنی های فولادی باید تعریف گردد.فقط برای سازه  National Loadلازم به ذکر است که نکته: 

کی در راستای ل که یتعریف گرددریا Nationalبرای هرکدام از بارهای ثقلی مرده و زنده باید دو بار از نوع 

X  و دیگری در راستایY باشد.می 
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 برای بار مرده National: تعریف بار 44شکل

 این کار برای سایر بارهای ثقلی هم باید تعریف گردد.

   P-ȹ  اثر    3-5
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نامه آئینبر اساس اشد؛ که بترکیب بار حاصل از بارهای ثقلی برای طراحی می P-Deltaترکیب بار حاکم بر 

ASCE7 باشد.رت زیر میوبص 

 

 Define > P-Delta Optionsمسیر: 

 

 ∆-P: تعریف ترکیبات بار 45شکل
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 جرم لرزه ای سازه 6-3

زلزله  موقع توجه به عدم مشخص بودن زمان زلزله احتمال اینکه در زلزله با براساس واقعیت رخداد

 است چون قسمتی از خیلی کمتر کند مشارکت جذب نیرو در و داشته باشد تمام وزن سازه حضور

نده حتما زتوان گفت که تمام بارهای موقع زلزله نمی باشد و دربارهای زنده می وزن سازه ناشی از

زان مشارکت می سازه)باتوجه به کاربری سازه( توجه به منطق استفاده از آیین نامه با دارد لذا  حضور

 تعریف کرده است. ورت زیربه صرا  موقع زلزله جهت جذب نیرو بارها در

W ار بر زنده و : وزن مؤثر لرزه ای , شامل تمام بار مرده و وزن تأسیسات ثابت به اضافه درصدی از با

ست. بارهای زنده و برف بر طبق مبحث ششم مقررات ملی ا( مشخص شده 2-3برف که در جدول )

 ساختمان در نظر گرفته می شود.

 

 Define > Mass sourceمسیر: 

 

 ای: تعریف جرم لرزه46شکل
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  ترکیبات بارگذاری 7-3

 ملاحظات کلی  3-7-1

ته از ساختمان های با مصالح بنایی که ن دسآکلیه ساختمان های موضوع این آیین نامه ، بجز  3-1-1

صل فط مندرج در این مقررات مندرج در فصل هفتم در آنها رعایت شده باشد ، باید بر طبق ضواب

 محاسبه گردند.

ثر ود و در هر عضو سازه اشمحاسبات ساختمان در برابر نیروهای زلزله و باد به تفکیک انجام می  3-1-2

طابق ه ، مضوابط ویژه طراحی برای زلزل هر یک که بیشتر باشد ، ملاک عمل قرار می گیرد. ولی رعایت

 نیاز سیستم سازه در کلیه اعضاء الزامی است.

، اثر مؤلفه شودمحاسبه ساختمان در نظر گرفته می زله که برایای افقی نیروی زلهبجز مؤلفه  3-1-3

 ذکر شده است باید منظور گردد. 9-3-3م نیروی زلزله نیز در مواردی که در بند ئقا

ید در دو امتداد عمود در هم در برابر نیروهای جانبی محاسبه شود . به طور کلی ساختمان با 3-1-4

در  یروی زلزلهنجز در موارد زیر به طور مجزا و بدون در نظر گرفتن  محاسبه در هر یک از این دو امتداد

 امتداد دیگر انجام می شود.

 پلان ساختمان های نامنظم در-الف

 ایی که در محل تقاطع دو و یا چند سیستم مقاوم باربر جانبی قرار دارند.کلیه ستون ه -ب

ا ایجاد ترین اثر ریه مناسبی که حتی المقدور بیشدر موارد الف و ب امتداد اعمال نیروی زلزله باید با زاو

لزله هر زمی کند ، انتخاب شود. برای منظور نمودن بیشترین اثر زلزله ، می توان صد در صد نیروی 

 بحرانی ترین در طراحی اجزاء ،درصد نیروی زلزله در امتداد عمود بر آن ترکیب کرد.  30امتداد را با 

 وهای داخلی حاصل از زلزله باید ملحوظ گردند. م نیرئحالت ممکن از نظر علا
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ستون در  : در ساختمان های مشمول بند ب فوق ، چنانچه بار محوری ناشی از اثر زلزله ، در 1تبصره

رکیب فوق درصد بار محوری مجاز ستون باشد ، بکارگیری ت 20هر یک از دو امتداد مورد نظر کمتر از 

 در آن ستون ضرورتی ندارد.

ر امتداد ددرصد نیروی زلزله  30هر امتداد با : در مواردی که ترکیب صد درصد نیروی زلزله  2تبصره

، برای  7-3-3عمود بر آن در نظر گرفته می شود ، منظور کردن برون مرکزی اتفاقی ، موضوع بند 

 درصد اعمال می شود ، الزامی نیست. 30نیروی زلزله ای که در امتداد مربوط به 

دادهای ساختمان باید در هر دو جهت آن امتداد یعنی به صورت زلزله در هر یک از امتنیروی  3-1-5

 رفت و برگشت در نظر گرفته شود.

ه برای تحلیل سازه در نظر گرفته می شود باید تا حد امکان نمایانگر وضعیت کمدل ریاضی  3-1-6

ی بی ، اجزایلیه اجزای مقاوم جانسازه به لحاظ توزیع جرم و سختی باشد. در این مدل باید علاوه بر ک

ن وند. در ایکه مقاومت و سختی آنها تأثیر قابل ملاحظه ای در توزیع نیروها دارند ، در نظر گرفته ش

ثر ترک ارتباط در سازه های بتن مسلح رعایت اثر ترک خوردگی اجزاء در سختی آنها الزامی است. ا

برای تعیین نیروهای داخلی و تغییر شکل ها در  5-6-3خوردگی در این سازه ها را می توان مطابق بند 

 تحلیل سازه منظور کرد.

صورت استفاده  استفاده کرد. در  CSAنامهو یا آئین ACIنامه توان از آئینمی های بتنیدر طراحی سازه

. اما در صورت های بتنی استفاده کردنام برای طراحی سازهباید از ترکیبات خود آئین ACIنامه از آئین

های بتنی هتوان از ترکیبات بار مبحث نهم مقررات ملی برای طراحی سازمی CSAنامه استفاده از آئین

 استفاده کرد.

 ACIنامه های بتنی را بر اساس آئیندسی ساختمان بیشتر طراحی سازهنمه با توجه به اینکه نظام

افزار توضیح در نرم ACIنامه جزوه نحوه تنظیمات ترکیبات بار بر اساس آئیندر این نماید، لذا کنترل می
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بر اساس مبحث نهم مقرات ملی ساختمان نیز در ادامه آورده شده داده خواهد شد. اما ترکیبات بار 

 است.

زله ترکیب درصد نیروی زل 30درصد راستای زلزله با  100بایست اثر در اکثر حالات طراحی، مینکته: 

 شود.گردد؛ لذا در ترکیبات بار طراحی مورد فوق نیز آورده می

 ترکیب بار مربوط به اثر مولفه قائم زلزله 3-7-2

 

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̸̺ 
 

های که در منطقه با خطر نسبی زیاد قرار ر تمام سازهد 1-9-3-3بنابراین با توجه به مورد الف بند 

ائم بری قثر مولفه گرفتن ا گرفته شود. برای درنظردارند)مانند شهر تبریز( باید مولفه قائم زلزله نیز در نظر 

 کل سازه بهتر است که، مقدار آن با بار مرده بصرت زیر در ترکیبات بار در نظر گرفته شود.

 های با اهمیت متوسط)مسکونی( داریم: مثلا برای سازه

 0.6*.35*1=0.21

میگردد. مثلا بار مرده بجای ضریب  جمع 0.21پس در ترکیبات مربوط به بار مرده، ضرایب بار مرده با 

1.2D  1.41مقدارD .2800رایش چهارم استاندارد یبا توجه به و ذکر است که هلازم ب بکار برده خواهد شد 

훺)ضریب اضافه مقاومت رود. همچنیندر ترکیبات بار بکار می 1مولفه قائم با ضریب  به در ترکیبات بار  (

 شود.مولفه قائم ضرب نمی

 افزارتعریف ترکیبات بار بر اساس پیش فرض نرم 3-7-3

نامه س آئینهای بتنی را بر اساسازهبه با توجه به توضیحات داده شده اگر بخواهیم ترکیبات بار مربوط 

ACI افزار تعریف نمائیم بصورت زیر اقدام خواهیم کرد.در نرم 

  Load Caseهای افقی در : تعریف ترکیب بار همزمان مولفهگام اول

 Define > Load Caseمسیر: 
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 Yدرصد زلزله راستای  30با  Xزلزله راستای  به : تعریف ترکیبات بار مربوط47شکل

 

 Xدرصد زلزله راستای  30با  Y: تعریف ترکیبات بار مربوط به زلزله راستای 48شکل
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 .یز باید تعریف گرددنEYAll-0.3EXو  EXAll-0.3Eyبه همین ترتیب ترکیب بار 

 نامه طراحی انتخاب آئینگام دوم: 

 Design > Concrete Frame Design > View/ Revise Preferencesمسیر: 

 

 های بتنی: انتخاب آئین نامه طراحی سازه49شکل

 

 فراخوانی ترکیبات بار پیش فرضگام سوم: 

 Define > Load Combinationsمسیر: 
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 های بتنی افزار برای سازهض نرم: فراخوانی ترکیبات بار پیش فر50شکل

 

 

 به ترکیبات مربوط به بار جانبی زلزله EVویرایش ترکیبات بار و اضافه کردن گام چهارم: 

  Define > Load Combinationsمسیر: 
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 مولفه قائم در راستای مثبت: اضافه کردن ترکیب بار مربوط به 51شکل
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 ای افزوده شود.ای لرزههبات مربوط به بارمولفه قائم زلزله باید در تمامی ترکی

  ACIتعریف ترکیبات بار بصورت دستی بر اساس  3-7-4

د بصورت زیر بصورت دستی وارد گرد ACIنامه های بتنی بر اساس آئیناگر بخواهیم ترکیبات بارگذاری سازه

 خواهد بود. 1-3و بر اساس جدول 

 Define > Load Combinationsمسیر: 

 

 تعریف ترکیب بار جدید :52شکل

 

 اضافه کردن ضرایب بارها: 53شکل
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 ACIهای بتنی بر اساس: ترکیب بار سازه1-3جدول 

و پیچش  (30-100های افقی)همزمانی مولفه ات بار بر اساس وجود مولفه قائم،ترکیب 1-3در جدول 

 به 0.69و  1.2به  1.41ده از اگر مولفه قائم وجود نداشته باشد؛ ضرایب بارمر تنظیم گشته است. تصادفی

 از ترکیبات حذف خواهد شد. Evتبدیل شده و   0.9

 ساختمان بر اساس مبحث ششم مقررات ملی ترکیبات بارگذاری سازه های بتنی 3-7-5

ملی  های بتنی از ترکیبات بار مبحث نهم مقرراتتوان برای طراحی سازهمی Etabsافزار در نرم

نامه آئین . برای استفاده از ترکیبات بار مبحث نهم مقررات ملی ساختمان،ساختمان نیز استفاده کرد

های سازه باشد؛ انتخاب گردد. روش طراحینامه ساختمانهای بتنی کانادا میکه آئین CSAطراحی باید 

رکیبات ت باشد.و مبحث نهم همانند هم بوده و بر اساس حالات حدی نهائی می CSAنامه بتنی در آئین

 آورده شده است. 2-3های بتنی بر اساس مبحث ششم مقررات ملی ساختمان در جدول سازهبار 

 

Combo Dead Live Live Partition Live Roof Snow ExAll EYAll EXALL+0.3Ey ExAll-0.3Ey EyALL+0.3Ex EYAll-0.3Ex EV

1 1.4

2 1.2 1.6 1.6 0.5

3 1.2 1.6 1.6 0.5

4 1.2 1 1 1.6

5 1.2 1 1 1.6

6 1.41 1 1 0.2 1 1

7 1.41 1 1 0.2 -1 1

8 1.41 1 1 0.2 1 1

9 1.41 1 1 0.2 -1 1

10 1.41 1 1 0.2 1 1

11 1.41 1 1 0.2 -1 1

12 1.41 1 1 0.2 1 1

13 1.41 1 1 0.2 -1 1

14 1.41 1 1 0.2 1 1

15 1.41 1 1 0.2 -1 1

16 1.41 1 1 0.2 1 1

17 1.41 1 1 0.2 -1 1

18 0.69 1 -1

19 0.69 -1 -1

20 0.69 1 -1

21 0.69 -1 -1

22 0.69 1 -1

23 0.69 -1 -1

24 0.69 1 -1

25 0.69 -1 -1

26 0.69 1 -1

27 0.69 -1 -1

28 0.69 1 -1

29 0.69 -1 -1
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 ملی های بتنی بر اساس مبحث ششم مقرراتبار سازه: ترکیبات2-3جدول 

 

( و پیچش 30-100های افقی)نیز ترکیبات بار بر اساس وجود مولفه قائم، همزمانی مولفه 2-3در جدول 

 به 0.64و  1به  1.21. اگر مولفه قائم وجود نداشته باشد؛ ضرایب بارمرده از تصادفی تنظیم گشته است

 از ترکیبات حذف خواهد شد. Evتبدیل شده و  0.85

 ترکیبات بارگذاری سازه های فولادی به روش طراحی بر اساس حالات حدی مقاومت 3-7-6

 دارد؛ (AISCنامه فولاد آمریکا)ئینبا توجه به اینکه مبحث دهم مقررات ملی ساختمان مطابقت زیادی با آ

حی بر های فولادی به روش طرالذا ترکیبات ارائه شده در مبحث ششم مقررات ملی ساختمان برای سازه

رای توان هم از ترکیبات بار پیش فرض برنامه بباشد. لذا میمی AISC( همانند LRFDاساس مقاومت)

ر افزادر نرم 3-3بات بار را بصورت دستی همانند جدول های فولادی استفاده کرد و هم ترکیطراحی سازه

 تعریف کرد.

Combo Dead Live Live Partition Snow or LRoof ExAll EYAll EXALL+0.3Ey ExAll-0.3Ey EyALL+0.3Ex EYAll-0.3Ex EV

1 1.25 1.5 1.5 1.5

2 1.21 1.2 1.2 1 0.84 1

3 1.21 1.2 1.2 1 0.84 1

4 1.21 1.2 1.2 1 0.84 1

5 1.21 1.2 1.2 1 -0.84 1

6 1.21 1.2 1.2 1 0.84 1

7 1.21 1.2 1.2 1 -0.84 1

8 1.21 1.2 1.2 1 0.84 1

9 1.21 1.2 1.2 1 -0.84 1

10 1.21 1.2 1.2 1 0.84 1

11 1.21 1.2 1.2 1 -0.84 1

12 1.21 1.2 1.2 1 0.84 1

13 1.21 1.2 1.2 1 -0.84 1

14 0.64 0.84 -1

15 0.64 -0.84 -1

16 0.64 0.84 -1

17 0.64 -0.84 -1

18 0.64 0.84 -1

19 0.64 -0.84 -1

20 0.64 0.84 -1

21 0.64 -0.84 -1

22 0.64 0.84 -1

23 0.64 -0.84 -1

24 0.64 0.84 -1

25 0.64 -0.84 -1
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( و پیچش 30-100های افقی)نیز ترکیبات بار بر اساس وجود مولفه قائم، همزمانی مولفه 3-3در جدول 

 به 0.69و  1.2به  1.41تصادفی تنظیم گشته است. اگر مولفه قائم وجود نداشته باشد؛ ضرایب بارمرده از 

 از ترکیبات حذف خواهد شد. Evیل شده و تبد  0.9

 AISCفولادی بر اساس مبحث شش مقررات ملی ساختمان و  های: ترکیبات بار طراحی سازه3-3جدول

 

 

 

 مدلسازی سازه 8-3

 مهاربند( ،)ستون، تیر فولادی با سیستم مقاوم جانبی مهاربندی مدلسازی سازه 3-8-1

 شود.ل مییر و ستون و بارهی جانبی توسط مهاربندها تحمدر این سیستم، بارهای قائم و ثقلی توسط ت

 انواع مهاربندها:

Combo Dead Live Live Partition NDX NDY NLX NLY NLPX NLPY NLRX NLRY Snow or LRoof ExAll EYAll EXALL+0.3Ey ExAll-0.3Ey EyALL+0.3Ex EYAll-0.3Ex EV

1 1.4 1.4

2 1.4 -1.4

3 1.4 1.4

4 1.4 -1.4

5 1.2 1.6 1.6 1.2 1.6 1.6 0.5 0.5

6 1.2 1.6 1.6 -1.2 -1.6 -1.6 -0.5 0.5

7 1.2 1.6 1.6 1.2 1.6 1.6 0.5 0.5

8 1.2 1.6 1.6 -1.2 -1.6 -1.6 -0.5 0.5

9 1.2 1 1 1.2 1 1 1.6 1.6

10 1.2 1 1 -1.2 -1 -1 -1.6 1.6

11 1.2 1 1 1.2 1 1 1.6 1.6

12 1.2 1 1 -1.2 -1 -1 -1.6 1.6

13 1.41 1 1 0.2 1 1

14 1.41 1 1 0.2 -1 1

15 1.41 1 1 0.2 1 1

16 1.41 1 1 0.2 -1 1

17 1.41 1 1 0.2 1 1

18 1.41 1 1 0.2 -1 1

19 1.41 1 1 1 1

20 1.41 1 1 -1 1

21 1.41 1 1 1 1

22 1.41 1 1 -1 1

23 1.41 1 1 1 1

24 1.41 1 1 -1 1

25 0.69 1 -1

26 0.69 -1 -1

27 0.69 1 -1

28 0.69 -1 -1

29 0.69 1 -1

30 0.69 -1 -1

31 0.69 1 -1

32 0.69 -1 -1

33 0.69 1 -1

34 0.69 -1 -1

35 0.69 1 -1

36 0.69 -1 -1
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 محدودیت در-4ابجایی جانبی کم ج-3کل پذیری کم ش-2ختی زیاد س-1(:CBFمهاربندهای هم محور) -1

 اجرای راحت-5بازشو 

 

 هایی از مهاربند هم محور: نمونه54شکل

قابلیت استهلاک انرژی  -3شترری بیشکل پذی -2سختی جانبی کمتر  -1:(EBFمهاربندهای برون محور) -2

 جرای نسبتا سخت در تیر پیوندا -5 عدم محدودیت درجایگذاری بازشوها -4بیشتر 

 ییتنها به کدام هر مرکز هم شده مهاربندی قاب و خمشی های بقا همچون فولادی مقاوم های سیستم

 توسط فهد دو هر تأمین و نمایند فراهم مطلوب صورت به را پذیری شکل و سختی عامل دو هر توانند نمی

 شده یمهاربند هایقاب پذیری شکل افزایش برای  .گردد می طرح شدن اقتصادی غیر باعث ها سیستم این

 الاب خواسته دو تأمین .گردید پیشنهاد 1978 درسال پوپوف توسط (EBF) مرکز از خارج مهاربند سیستم

 ینا بزرگ ضعف ولی .کرد رای  مختلف های نامه آیین در ار کارگیریآن به سرعت سیستم،به این توسط

 زلزله یک از پس آن تعمیر یا تعویض و باشد می اصلی تیر از قسمتی که خود باشد می پیوند تیر سیستم

 .باشد مشکل می بسیار شدید
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 هایی از مهاربند برون محور: نمونه55شکل

 پیوند یا لینک گیرد می قرار مهاربند دو بین یا تونس تا قطری عضو بین که تیر از قسمتی سیستم این در

 به خود طریق از را مهاربندی نیروهای تواند می که است خاصیت این دارایتیر پیوند   شود، می نامیده

 در پیوند واقع رد .سازد وارد مهاربند به را متعادلی نیروهای نهایتاً و دهد انتقال دیگر قطری عضو یا ستون

 در .ندک می جذب را زلزله انرژی از ای عمده مقادیر خود و کنند می عمل پذیری شکل یوزف مانند اینجا

 صلهایمف تشکیل با  که است پیوند تیر این یک طراحی برای سیستم مهاربند برون محور طراحی در واقع

 تیح که شوند طراحی طوری باید قطری عناصر. کند تحمل را ارتجاعی غیر بزرگ شکلهای تغییر خمیری،

 نقشی نآ شدن زیاد یا کم و پیوند طول علت، همین به نکنند.  کمانه هم شدید جانبی بارهای مقابل در

 .گیرد می عهده بر سیستم رفتار در اساسی

 

 : موقعیتهای متفاوت تیر پیوند56شکل
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 (:KBF)مهاربندهای زانوئی -3

 چواآ .شد مطرح آچوا توسط پذیر کمانش زانویی مهاربند سیستم 1986 سال در مشکل این رفع برای

 هر پذیری شکل و وسختی کند تحمل را کشش فقط که شود طراحی طوری قطری عضو کرد پیشنهاد

 در که بود قطری عضو لاغری آچوا پیشنهادی سیستم عمده مشکل. گردد تأمین زانویی عضو توسط دو

 تغییراتی نجاما با بالندرا 1990 سال در  .نبود مناسب ای لرزه طرح برای و نمود می کمانش سریعاً فشار

 دمهاربن سیستم است، شده گرفته آن کمانش جلوی که قطری عضو یک از استفاده و فوق سیستم در

 به و پذیری شکلبالندر پشنهادی سیستم در  .نمود پیشنهاد راKBF (Knee Braced Frame) زانویی

 ازد بع .است شده تأمین طریق عضو توسط سختی و زانویی عضو توسط انرژی استهلاک آن  تبع

 در زانویی عضو هنگامی شد، مشخص زانویی مهاربند سیستم روی شده انجام مقیاس تمام آزمایش

 شده ایجاد هیسترزیس های حلقه گردد می طراحی جانبی پیچشی کمانش و محلی کمانش مقابل

 .روند می پیش به سختی کاهش بدون و منظم

 

 
 د زانوئیهایی از مهاربن: نمونه57شکل

 

یز ن کلاندی هاربنو م مایکروبه غیر از مهاربندهای رای  ذکر شده در بالا مهاربندهایی از جمله مهاربند 

 .وجود دارد که در آینده کاربرد فراوانی در صنعت ساختمان کشورمان خواهند داشت
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 ترسیم ستون 3-8-1-1

حالت پلان  برای ترسیم ستون در یم نمود.ستونها را می توان هم در حالت پلان و هم در حالت نما ترس

 و نما از مسیر زیر یا آیکن های نشان داده شده از ابزارهای ترسیم استفاده نمود.

 Draw > Draw Beam/ Column/ Brace Objectمسیر: 

 

 : ترسیم ستونها در حالت پلان58شکل

 

 

دی میازه مهاربنجه به اینکه سیستم مقاوم جانبی سشود. اما با توترسیم تیرها نیز همانند ستونها انجام می

ون تیر به ست در نظر گرفته شود. برای مفصلی کردن اتصالاتباشد، لذا بایستی اتصالات تیر به ستون مفصلی 

 انتخاب گردد. Pinnedگزینه   Moment Releasesکافی است در پنجره شناور ترسیم تیر در قسمت 

 ترسیم مهاربندها 3-8-1-2

 پنجره شناور آیکن ترسیم ستون

 کرد که اتصال ستون به ستون همیشه گیردار است.در ترسیم ستونها باید دقت  توجه:
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 ی شود.ماستفاده  یکن نشان داده شدهی ترسیم مهاربندها ابتدا قاب مورد نظر انتخاب و از مسیر زیر و یا آبرا

 Draw > Draw Beam/ Column/ Brace Objectمسیر: 

 

 

 Aمهاربند ضربدری در قاب : ترسیم 59شکل

 

 

 

 

 

 

 

 

 .خواهد بود (Pinned)اتصال مهاربندها به تیر و ستون در هر حالت مفصلی: 1توجه

مهاربندها باید طوری در سازه قرار بگیرند که باعث خروج از مرکزیت در سازه نگردند. برای این منظور باید بصورت : 2توجه

ر گیرند. وجود پیچش درسازه باعث پیچیده گی رفتار سازه و آسیب پذیر شدن سازه در متقارن در طرفین مرکز جرم قرا

 مقابل نیروی های ناشی از زلزله می گردد. 

با توجه به اینکه با افزایش فاصله از مرکز سختی، سختی پیچشی مهاربندها افزایش می یابد، باید دقت کرد تا جایی : 3توجه

 قابهای پیرامونی سازه قرار گیرند تا از حداکثر ظرفیت مهاربندها استفاده شود.که امکان دارد مهاربندها در 

توان برای ترسیم از قسمت نشان داده شده می

 انواع مهاربندها استفاده کرد.
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 : رفتار سازه در صورت وجود خروج از مرکزیت جرم یا سختی60شکل

میناشته باشد پیچش درسازه بوجود سختی نسبت به هم خروج ازمرکزیت ند جرم و اگرمرکز درسازه ها

به  راستا چون المان های مقاوم جانبی هر رفتاری مطلوبترین حالت است. سازه ازنظر این حالت از آیدکه

روج سختی خ جرم ومواقعی که مابین مرکز در اما برد نیروهای جانبی سهم خواهند از نسبت سختی خود

ها درمقابل هعامل باعث پیچیده شدن رفتارساز که این ؛شودمی سازه پیچش القا در آیدمیازمرکزیت بوجود 

 چون در؛ دبو رفتارسازه قابل پیش بینی نخواهد سازه پیچش بوجود بیاید در اگر گردد.نیروهای جانبی می

علاوه برالمانونسبت سختی نبوده  به دیگر هاالمان در میزان توزیع نیرو هاء شدن پیچش درسازهقع القاامو

 جانبی سهم نیروهای جهت زلزله نیز از بر های مقاوم جانبی راستای عمودهای مقاوم جانبی هرراستا المان

 شود.در مقابل زلزله می هارفتارسازه برد که این عامل باعث پیچیدگی هرچه بیشتر خواهد

دون پیچش بسبت به حالت ن هالزوما سازه آیدهایی که پیچش بوجود میسازهدر  ،تجربه نشان داده است که

 ست کهاچون واکنش سازه درمقابل پیچش به پارامترهای بیشتری وابسته  باشند. تواند آسیب پذیرترمی

ی و سازه های دارای پیچش عوامل دینامیکی نیروهای جانبدهد که، در سازهمطالعات انجام شده نشان می

ر دواقع زلزله به این دلیل امکان ناپایداری سازه در م، که ها خواهند داشتدر رفتار سازه ،ت بیشتریدخال

زه جرم سا امکان به مرکز سازه تاحدnvسختی  که مرکز شودتوصیه مییابد.ها افزایش میاین سازه

 ازمقدارآن کاسته شود. یا و آمدن پیچش جلوگیری بوجود از تا نزدیک باشد
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تی درفاصله، قاوم جانبی به نسبت سخهای منتوان نتیجه گرفت که المامی به توضیحات داده شده،  با توجه

 بیشترختی س مرکز های مقاوم جانبی ازفاصله المان هرچقدر لذا؛ بردسازه سهم می آمده در ازپیچش بوجود

 . داشت دنسهم بیشتری ازپیچش خواه باشد

پیچش  )لبه سخت(کمتراست نسبت به مرکز جرم سختی صله آن ازمرکزفاای که هایی، در لبهدر چنین سازه

 که فاصله آن از مرکز سختی نیبت به مرکز جرم بیشتر است)لبه نرم( ایباعث کاهش پاسخ سازه و در لبه

باعث  کاملا متفاوت نسبت به هم دارند سخت که رفتار ی نرم ومعقوله لبه دو لذاپاسخ سازه افزایش یابد. 

 گردد. بسیارآسیب پذیرتر و شود پیچیدگی زیادی برخوردار ه سازه ازشوندکمی

 

 

 مدلسازی سازه فولادی با سیستم مقاوم جانبی قاب خمشی  2-8-3

ستون  و خمشی برشی تیر رفتاردر این نوع سیستم بارهای ثقلی توسط تیر و ستون و بارهای جانبی توسط 

 خصوصیات این نوع سیستمها عبارتند از: تحمل می گردد.

 -5دم محدودیت بازشوها ع -4اد به پایداری بالا قابلیت اعتم -3م کسختی جانبی  -2شکل پذیری بالا -1

اده درسازه های با قابلیت استف -6)به علت داشتن اتصالات گیردار و جوش نفوذی در این اتصالات( اجرای نسبتا سخت

 بیشتر یی جانبیجابجا -8زینه ساخت نسبتا بالا ه -7تعداد طبقات بالا 

قت کرد در سیستم قاب خمشی مدلسازی ستون همانند سیستم قبل خواهد بود. ولی در ترسیم تیرها باید د

 که، اتصالات تیرها به ستونها گیردار خواهند بود. لذا ترسیم تیرها بصورت زیر خواهد بود.
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 : ترسیم تیرها در قاب خمشی 61شکل

اده نشود. بندی از تیرهای مورب استفا قاب خمشی، برای قابهای فولادی بلازم به ذکر است که در سازه

ه اتصال صلب تیر ب نشیمن مناسب برای تامین چون در سیستم قاب خمشی فولادی، در تیرهای مورب 

 وجود ندارد. ستون 

 

 .( ترسیم المانهای سطحی)سقف،دیوار، رمپ و .... 3-8-3

 ترسیم سقف طبقات 3-8-3-1

ی شود. از مسیر زیر و یا آیکن های نشان داده شده در شکل زیر استفاده مبرای ترسیم سقف طبقات 

 برای ترسیم کف طبقات باید حالت نمایش در حالت پلان باشد.

 Draw > Draw Floor/wall Objectsمسیر: 
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 : ترسیم سقف تیرچه و بلوک در تمام طبقات 62شکل

 

 اصلاح مدلسازی 9-3

 Baseصلاح خرپشه و ا 3-9-1

اصلاح گردد.  Baseد از ترسیم المانهای سطحی و خطی در تمام طبقات باید طبقه خرپشته و بع

همچنین برای اعمال رفتار واقعی سازه باید یکسری تنظیمات روی مدل انجام شود که به ترتیب زیر 

بقه ط تیر، ستون و سقفدر اصلاح طبقه خرپشته باید دقت کنیم هیچ المانی به غیر از  شود.اعمال می

ابتدا حالت  برای این کار .نیز نباید هیچ المانی باقی بماند  Baseخرپشته باقی نماند. همچنین در طبقه 

  مدل می شود. چرا؟ openingراه پله بصورت توجه: 
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همه المانهای اضافی  Baseشود. سپس با انتخاب طبقه خرپشته و قرار داده می one Storyدر طبقه 

 خواهد بود. 64و  63شکلهایگردد؛ بطوری که در این دو طبقه موارد موجود بصورت پاک می

 

  پلان مدلسازی سقف خرپشته: 63شکل

 

 بعد از اصلاح Base: نمایش پلان 64شکل
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 اختصاص تکیه گاهها 3-9-2

( از مسیر زیر تکیه گاهها one storyبعد از انتخاب تمام گره ها)در حالت   Baseدر پلان طبقه 

 اختصاص داده می شود.

 Assign > Joint > Restraints   مسیر:

 

 گاههانمایش درجات آزادی تکیه: 65شکل

یر آورده تنظیمات مربوط به حالتهای مختلف سیستم مقاوم جانبی در دو راستای عمود بر هم در شکلهای ز

 شده است.  

 

و برای برای سازه هایی با سیستم مهاربندی تکیه گاهها مفصل نکته: 

 سازه هایی با سیستم قاب خمشی تکیه گاهها گیردار خواهند بود.

وجود تیک در هر کدام از گزینه ها به منزله بستن آن درجه : 2نکته

 آزادی می باشد.
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 قاب ساده: درجات آزادی مربوط به سیستم مقاوم جانبی 66شکل

 

 : درجات آزادی مربوط به سیستم مقاوم جانبی قاب خمشی67شکل

 

 خمشی( Yو راستای  مهاربندی X: درجات آزادی مربوط به سیستم ترکیبی)راستای 68شکل
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 مهاربندی( Yخمشی و راستای  X: درجات آزادی مربوط به سیستم ترکیبی)راستای 69شکل

 اختصاص دیافراگم 3-9-3

نگام ه، در  دیافراگم ها که معمولا کف های سازه ای تحمل کننده بارهای ثقلی در ساختمان ها هستند

دارند.  ی بر عهدهوقوع زلزله وظیفه انتقال نیروهای جانبی ایجاد شده در کف ها را به عناصر قائم باربر جانب

دارا  ختی کافی را، مقاومت و سبر تغییرشکل های افقی که در آنها ایجاد می شود اردر باین دیافراگم ها باید 

 باشند.

طور کلی  یافراگم ها باید به طور مناسب در نظر گرفته شود. بهدر تحلیل سازه ساختمان اثرات صلبیت د

 دیافراگم ها به سه دسته نرم ، نیمه صلب و صلب تقسیم می شوند.

ه شده ه ) محاسبدر دیافراگم هایی که حداکثر تغییر شکل افقی ایجاد شده در آنها زیر اثر نیروی جانبی زلزل

لقی می شود. تمکان نسبی متوسط طبقه باشد , دیافراگم نرم و برابر تغییر( بیش از د 6-3-3بر طبق بند 

یستم سدیافراگم های از نوع چوبی یا ورق های فلزی تقویت نشده بدون پوشش بتن در سازه های دارای 

ازه های جانبی با دیوارهای برشی یا قاب های مهاربندی شده ممکن است در این دسته قرار گیرند. در س

 بندهای   رم نیازی به در نظر گرفتن اثرات  لنگرهای پیچشی در ساختمان بر  طبقدارای دیافراگم های ن

زیع نیروی برشی زلزله بین اجزای قائم مقاوم در برابر زلزله بر اساس نبوده و تو 3-7-3-3و  3-3-7-2

  .موقعیت و جرم سهمیه این اجزا انجام می شود

نصف  له کمتر ازد شده در آن ها زیر اثر نیروی جانبی زلزدیافراگم هایی که حداکثر تغییر شکل افقی ایجا در

رق وبتنی یا  تغییر مکان نسبی متوسط طبقه باشد ، دیافراگم صلب تلقی می شود . دیافراگم های از نوع دال

نامنظمی  یا کمتر که دارای هیچ یک از 3های فلزی همراه با بتن مسلح رویه دارای نسبت دهانه به عرض 

 د . نباشد ، ممکن است در این دسته قرار گیرن 1-7-1بند های مندرج در 

د ازه ، بایسسایر دیافراگم ها نیمه صلب محسوب شده و اثر سختی نسبی آن ها در توزیع نیروها بین اجزای 

 با مدل کردن دیافراگم ها ، در نظر گرفته شود .

تمان بر ت لنگرهای پیچشی در ساخدر سازه های دارای دیافراگم های صلب و نیمه صلب درنظر گرفتن اثرا

 . الزامی است 3-7-3-3و  2-7-3-3طبق بندهای 

ی خمشی ناشی از نیروی نگرهالدیافراگم های صلب و نیمه صلب باید برای تلاش های برشی و  3-8-2

 ( محاسبه می شوند . 14-3فراگم ها طراحی شوند . نیروی مذکور بر طبق رابطه ) مؤثر بر دیا
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Fpi = ( ∑
Fj

Wj

n
j=1  ) Wi                                                                                    )3-14( 

 در این رابطه :

 piF :  نیروی جانبی وارد بر دیافراگم در تراز i 

iW  وزن دیافراگم و اجزای متصل به آن در تراز :i  1-3-3ند ب، شامل قسمتی از بار زنده مطابق ظابطه . 

 jF و jW 6-3-3بق تعاریف بند وهای وارد به طبقه و وزن طبقه مطا: به ترتیب ، نیر . 

در  iIWA لازم نیست بیشتر ازداکثر آن حاست و  iAIW 5/0برابر با   piFدر رابطه فوق ، حداقل مقدار 

ائمی قی اعضای یروی جانبنظر گرفته شود . در صورتی که لازم باشد دیافراگم علاوه بر نیروی زلزله طبقه ، ن

ار این اید ، مقدرا که در قسمت بالا و پایین دیافراگم بر روی یکدیگر واقع نشده اند ، به یکدیگر منتقل نم

د . در این حالت اثر ضریب نامعینی سازه ( اضافه شو14-3نیروها نیز باید به نیروی به دست آمده از رابطه )

 این بخش از نیروها نیز باید در نظر گرفته شود . ه مقادیربرای محاسب 1-1-3-3طبق بند 

 ای شناختهتلاش های داخلی و نیز تغییر شکل های ایجاد شده در دیافراگم ها باید با استفاده از روش ه

و فاقد  شده تحلیل سازه ها تعیین گردند .در دیافراگم های متعارف که دارای پلان نسبتا منظمی بوده

گم رد دیافراه هم باشند ، این تلاش ها و تغییرشکل ها را می توان با فرض عملکبازشوهای بزرگ و نزدیک ب

مقاومت ل به صورت تیر تیغه ای که بر روی تکیه گاه های ارتجاعی قرار گرفته است ، تعیین نمود .کنتر

 مصالحده از و دیافراگم های ساخته ش «آبا»دیافراگم های بتن مسلح بر اساس ضوابط آیین نامه بتن ایران 

دیگر براساس ضوابط آیین نامه های مربوط تعیین می گردد.

جزای مقاوم در ( برای انتقال بار از دیافراگم ها به ا collectorدر مواردی که تعبیه اجزای جمع کننده ) 

نظر ا در یبات بار ب، طراحی این اجزا و اتصالات آنها باید با استفاده از ترکبرابر بارهای جانبی ضروری باشد 

 انجام شود . ) 0ɋگرفتن ضریب مقاومت افزودن ) 

و یا نامنظم در ارتفاع به  1-7-1م در پلان به لحاظ شرایط )الف( ، )پ( یا )ت( بند در کلیه سازه های نامنظ

در پهنه های با خطر نسبی متوسط و بالاتر ، نیروی طراحی اتصالات دیافراگم  2-7-1لحاظ شرط )پ( بند 

 افزایش یابد . %25و اجزاء جمع کننده باید به میزان به اجزاء قائم 

 

 Select > Select >  Object Type> Floor           Assign > Shell > Diaphragmsمسیر: 

صلبیت در انواع سقفها چگونه تامین می : سوال

شود؟
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 : تنظیمات مربوط به اختصاص دیافراگم به سازه70شکل
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 اختصاص انتهایی صلب   3-9-4

تحلیل  ده محور مرکزی)آکس( المانها می باشند؛ از طرفی درخطوط مدل شده نماین Etabsدر نرم افزار 

ایی صلب انته سازه باید طول آزاد المانها مدنظر باشد. به همین خاطر باید از مسیر زیر با اختصاص نواحی

 طول آزاد المانها مشخص شود.

 

 

 All                        Assign > Frame > End length offsetsمسر: 

 

 : اختصاص نواحی صلب انتهائی71شکل
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 تغییر جهت تیرچه ها 3-9-5

 توان جهت برای در نظر گرفتن بحرانی ترین حالت بارگذاری و همچنین اجرایی کردن تیرها در هر طبقه می

های زه از بارتیرریزی را بصورت شطرنجی انتخاب کرد. در این حالت تیرهای هر دو راستا تقریبا به یک اندا

شته ید توجه دااین کار باعث بهبود رفتار سازه نیز می گردد. لازم به ذکر است که بابرند که  ثقلی سهم می

اه پله رباشیم جهت تیر ریزی در صورت امکان طوری انتخاب شود که کمترین بار ثقلی به تیرهای اطراف 

 کنیم. ر عمل میمورد نظر از مسیر زی یهاجهت تیرچه ها بعد از انتخاب پانلبرای تغییر  وارد  شود.

  Assign > shell > Local Axesمسیر:

  
 ریزی: تغییر جهت تیر72شکل

 
 ریزی شطرنجی طبقات: تیر73شکل
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 آزاد سازی انتهایی تیرها 3-9-6

 ه در موقعدر سازه های فولادی مهاربندی شده اتصالات تیر به ستونها مفصلی می باشد. با توجه به اینک

صلی ه اتصال مفباشد باید این اتصالات بامه برای تیرها از نوع گیردار میرض برنترسیم تیرها اتصال پیش ف

 کنیم.انتخاب تیرها از مسیر زیر عمل میتبدیل شوند. برای آزاد سازی انتهای تیرها بعد از 

    Select >Select  Object Type > Beams >               Assign > Frame > Releases/Partial Fixityمسیر:  

 

 : آزادسازی انتهائی تیرها74شکل

 

 اختصاص مشخصات 10-3

اطع به صاص داده شود. برای اختصاص مقاخت باید مشخصات مقاطع به المانهابعد از اصلاح مدلسازی 

 های فولادی دو روش وجود دارد.المانها در سازه

طع مورد نظر اختصاص داده یر مقدر این روش ابتدا المان مورد نظر انتخاب و سپس از مسیر ز روش اول:

بندی شود، پس تیپمی با توجه به اینکه در این روش برای هر عضو مقطع دلخواه اختصاص داده شود.می
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اما برای افراد کم تجربه استفاده از این روش به دلیل طولانی بودن پروسه  .استانجام  قابل مقاطع براحتی

 شود.طراحی توصیه نمی

 Assign > Frame > Section Propertyمسیر: 

ده است در این روش ابتدا برای هر نوع المان یک جعبه مقاطع مناسبی که قبلا توضیح داده شروش دوم:

ب برای شود. در این روش، مقطع مناسمی داده صتهیه و به المانها اختصا  Auto Select Listتحت عنوان 

 ین روش بهدر ا گردد.برای المانها انتخاب می عریف شدههر المان از بین مقاطع موجود در جعبه مقاطع ت

جرایی و عملا ا دلیل انتخاب مقطع بر اساس ظرفیت مورد نیاز در هر المان، تنوع در تعداد مقاطع بیشتر بوده

 بعد از طراحی باید مقاطع اجرایی گردند. ،نخواهد بود. برای تیپ بندی المانها

 مل می کنیم:برای اختصاص مقاطع در این روش بصورت زیر ع

 ستونها:

 Select >Select  Object Type > Columns           Frame > Section Property >  Column 

 

  Auto Select List: اختصاص مقطع بصورت75شکل

 گیرد.و مهاربندها نیز این کار صورت میبرای تیرها 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̸͈ 
 

  بارگذای ثقلی سازه  11-3

دارد که بارهای گسترده یکنواخت بصورت یک بسته  این امکان وجود Etabs 2013افزار در نرم

ام و . لذا برای ب( از مسیر زیر تعریف شده و در نهایت اختصاص یابدUniform lead Setsبارگذاری)

 شود.طبقات دو بسته بارگذاری بصورت جداگانه تعریف می

 Define > Shell Uniform Loead Setsمسیر: 

 

 

 رده بامبسته بارگذاری گست :76شکل

̬ 
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 : بسته بارگذاری گسترده طبقات77شکل

 

 

 بارگذاری بام: 3-11-1

 اعمال بارهای گسترده بامگام اول: 

 بعد از انتخاب سقف طبقه بام از مسیر زیر بارگذاری اعمال می شود.

Assign >shell load > Uniform Load Sets 

̬ 
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 : اعمال بسته بارگذاری بام78شکل

 دیوارهای جانبی در بام wallگام دوم: بارگذاری 

 بعد از انتخاب تیرهای اطراف بام از مسیر زیر اعمال می گردد.

 Assign > Frame loads > Distributedمسیر: 

 

 دیوارهای جانبی در بام Wallبار : اعمال 79شکل

̬ 
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 : بارگذاری دیوارجان پناه در بامسومگام 

 مال می گردد.بعد از انتخاب تیرهای اطراف بام از مسیر زیر اع

 Assign > Frame loads > Distributedمسیر: 

 

 پناه در بام: اعمال بار دیوار جان80شکل

 گام چهارم: بارگذاری آسانسور

ر، توسط وزن ظرفیت )وزن نفرات( آسانسوهای تعادل و بار آسانسور آعم از وزن اتاقک، تجهیزات، وزنه

ب ضربه طرفی مبحث ششم مقررات ملی برای بار آسانسور ضریشرکت سازنده آسانسور اعلام خواهد شد. از 

در ای را پیشنهاد داده است. پس وزن آسانسور با اعمال ضریب ضربه در تراز طبقه بام بصورت نقطه 2

ود، با شتن در نظر گرفته  3چهارگوشه موقعیت آسانسور بصورت زیر اعمال خواهد شد. اگر وزن آسانسور 

 هد شد.تن اعمال خوا 5/1تن خواهد بود؛ که برای هر گوشه آسانسور  6اعمالی اعمال ضریب ضربه، بار 

 شود.ابتدا چهار گوشه موقعیت آسانسور انتخاب شده، سپس بار از طریق مسیر زیر اعمال می

 Assign > Jiont Loads > Forceمسیر: 

 

̬ 
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 ای آسانسور: اعمال بار نقطه81شکل

 بارگذاری طبقات: 3-11-2

 عمال بارهای گسترده بامگام اول: ا

 بعد از انتخاب سقف طبقه بام از مسیر زیر بارگذاری اعمال می شود.

Assign >shell load > Uniform Load Sets 

 

 : اعمال بسته بارهای گسترده طبقات82شکل
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 بارگذاری دیوارهای جانبی طبقات: گام دوم

 مال می شود.بعد از انتخاب تیرهای پیرامونی از مسیر زیر بارگذاری اع
Assign > Frame loads > Distributed 

 

 بار دیوارهای پیرامونی طبقات: اعمال 83شکل

 : بارگذاری دیوارهای جانبی راه پلهسومگام 

 از مسیر زیر بارگذاری اعمال می شود. پلهراه بعد از انتخاب تیرهای پیرامونی

Assign > Frame loads > Distributed 

 

 ر دیوارهای پیرامونی راه پله: اعمال با84شکل
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 بارگذاری راه پله:

 پله دو طرفه:

 

 CDو  ABیرهای در پله دو طرفه بار در روی تکند. لذا پله دو طرفه هملنند دال یکطرفه بار را پخش میراه

 در تراز طبقات اعمال می گردد.

 

 :پله سه طرفه
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پله اه، که مقدار آن نصف کل بار رهد داشتبار خطی در تراز طبقات خوا  ABدر پله سه طرفه فقط تیر

 .هد شدپله وارد خوایک چهارم کل بار راهبار محوری در تراز طبقات  Dو  Cستونهای  به وخواهد بود 

می  ر چهار ستون اعمالتوضیح: در راه پله چهار طرفه بار پله بصورت متمرکز در تراز طبقات به ه

 شود.

 

 تحلیل سازه  4

ریف لزله و تعسازه باید تحلیل شود. با توجه به نوع بارگذاری ز ،سازی و بارگذاری سازهبعد از اتمام مدل

ات اید تنظیمببارهای جانبی، تحلیل در این مرحله تحلیل استاتیکی معادل خواهد بود. قبل از انجام تحلیل 

 لازم صورت گیرد.

 Analyzeتنظیمات منوی  6-1

 Analyze > Set Active Degrees of freedomمسیر:

  

 بعدی: تنظیم تعداد درجات آزادی مدل سه85شکل

 تنظیم الگوهای بار برای تحلیل 4-2

توان از این قسمت آنها را در صورتی که بخواهیم تعدادی از الگوهای بار تعریف شده، تحلیل نشوند، می

 تحلیل آن را غیر فعال نمود. Run/Do Not Run Caseبوسیله گزینه انتخاب و 
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 Analyze > Set load Cases to Runمسیر: 

 : انتخاب الگوهای بار برای تحلیل86شکل 

 کنترل مدلسازی و جزئیات  4-3

 Analyze > Check Model مسیر: 

 

 : کنترل مدلسازی87شکل
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 در صورت نبود مشکل پیغام زیر نمایش داده می شود.

 

 : نمایش پیغام برای ایرادات و اشکالات مدلسازی88شکل 

 روع تحلیلش 4-4

 Analyze >Run Analysisمسیر: 

وما شود؛ لزل میافزار حاصای که از نرمهر نتیجهگردد. اما باید دقت کنیم که در این مرحله سازه تحلیل می

زه سا طلاعاتاقابل قبول نخواهد بود. چون همجنان که قبلا نیز گفته شده است، با توجه به اینکه بخشی از 

باشد؛ پس افزار نیز بعلت قفل شکسته بودن دارای خطا میردد  و همچنین خود نرمگتوسط طراح تعریف می

 توان گفت در رابطه با اطلاعات خروجی باید دقت کافی بعمل آید.می

 کنترل خروجی های تحلیل 4-5

 اصل شود.حبعد از تحلیل سازه باید نتای  تحلیل و خروجی های آن کنترل شود تا از صحت تحلیل اطمینان 

  Analyze > Last Analysis Run Log   رل گزارش تحلیل:تگام اول: کن
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سازه  باید WARNING  وجود داشته باشد. در صورت وجود WARNINGدر گزارش تحلیل نباید هیچ گونه 

ازه را برطرف نمود باید مدلسازی و تحلیل س WARNINGبررسی و مشکل رفع گردد. در صورتی که نتوان 

 مشاهده گردد.   ANALYSIS COMPLETEدر پایان هر گزارش باید  و دوباره انجام شود.

: نمایش گزارش تحلیل89شکل

 گام دوم: کنترل تغییر شکل استاتیکی سازه

ر مایش تغیینسازه در تحلیل استاتیکی معادل باید بر اساس مود اول، تغییر شکل جانبی داشته باشد. برای 

 د.شکلهای سازه از مسیر زیر اقدام می شو

 Display > Deformed shapeمسیر: 
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 تغییر شکل جانبی سازه: نمایش 90شکل
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 نمایش خروجی های تحلیل 5

 برای نمایش خروجی های تحلیل بصورت زیر اقدام می شود.

 المانهانمایش نیروهای داخلی  1-5

 Display > Forces/ Stress Diagram > Frame/ pier/ Spandrel/link Forcesمسیر: 

 

 

  نمایش سایر جزئیات سازه -1

 

 

 

 

 

    Display > Show Tablesمسیر: 

 

 نیروهای داخلی المانها: نمایش 91شکل

 

 

 Show Tables نمایش خروجی های از قسمت  5-2

 Display > Show Tablesمسیر: 
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 نمایش نتایج تحلیل
 

 

 

 

نمایش مرکز جرم و سختی  و جرم طبقات 

 و برش طبقات

نمایش زمان تناوب 

 و فرکانس مودها

 نمایش برش پایه

 بررسی جابجایی ها طبقات

 

 مراکز سختی طبقات جرم طبقات مراکز

 

CRX-cmX 

CRY-cmY 
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 انجام تحلیل دینامیکی طیفی  6

ه ه استفادساز ده است، در صورتی که نتوان از تحلیل استاتیکی معادل برای تحلیلهمچنان که قبلا گفته ش

و  ع و کارآمدهای دینامیکی استفاده نمود. تحلیل دینامیکی طیفی، یک تحلیل بسیار سریکرد باید از تحلیل

ها از سازه یتوان برای بسیارمی 2800باشد که طبق آیین نامه  یتقریبا دقیق دینامیکی در محدوده خطی م

 بکار گرفت.

 روشهای تحلیل دینامیکی  6-1

شی از نا «زمین  حرکت »در این روش ها اثرات زلزله بر ساختمان با استفاده از بازتاب دینامیکی سازه در اثر 

       شو رو «تحلیل طیفی  »این روش ها شامل روش  زلزله و با فرض رفتار خطی سازه تحلیل می شود ، 

شده است .  توضیح داده 2-4-3و  1-4-3است که جزئیات آن ها در بندهای  «خچه زمانی تحلیل تاری »

ات است . مشخص 2-2-3کاربرد هر یک از این دو روش در ساختمان های مشمول این آیین نامه تابع بند 

 تعیین می گردد . 5-2حرکت زمین که در این مورد استفاده قرار می گیرد طبق ضوابط بند 

یره ، مبنا و غ کار برده می شوند نظیر جرم ، نسبت شتابمترهایی که در تحلیل دینامیکی بلیه پاراتبصره : ک

 همان مقادیری هستند که در تحلیل استاتیکی معادل تعریف شده اند .

 روش تحلیل طیفی 6-2

 شده است ،ی تهیه در این روش ، ابتدا تحلیل مقادیر ویژه بر روی مدل سازه که بر اساس رفتار خط 6-2-1

ا توجه انجام شده و مشخصات مدهای طبیعی نوسان آن تعیین می گردد . سپس حداکثر بازتاب در هر مد ب

عیین می تبه زمان تناوب آن مد از طیف طرح بدست آورده شده و با ترکیب آماری آنها بازتاب کلی سازه 

 گردد .

 باید رعایت شود . 2800نامه آئین  8-2-4-3تا   2-2-4-3الزامات بندهای ، در این روش تحلیل 

 وارد کردن طیف طراحی  6-2-2

اب د از انتخطیف طراحی آئین نامه بر اساس نوع خاک و لرزه خیزی منطقه از آئین نامه انتخاب می شود. بع

 طیف طرح باید این طیف در نرم افزار فراخوانی شود.
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 ر نسبی متوسط و کمبرای منطقه با خط 2800طیفهای طراحی آئین نامه : 92شکل

 

 برای منطقه با خطر نسبی زیاد و خیلی زیاد 2800طیفهای طراحی آئین نامه : 93شکل
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 Define > Functions > Response Spectrum:فراخوانی طیفمسیر

 

 فراخوانی طیف طراحی: 94شکل

 الگوی بارگذاری طیفی تعریف 6-2-3

 Define > Load Casesمسیر: 

 یف الگوی بار برای تحلیل طیفیتعر: 95شکل 
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 xتعریف الگوی بار در راستای : 96شکل

 

 

  

  

Scale factor: 
∗ ∗

 

. لازم به ذکر است در برای هر راستا الگوی بار جداگانه ای تعریف می شود

صورتی که پیچش تصادفی نیز وجود داشته باشد باید الگوی بار مناسب با 

 آن تعریف گردد.

 Xراستای 
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 بارگذاری طیفی  پیچش تصادفی در  با بار تعریف الگوی 6-2-4

 

 

 xتعریف الگوی بار  پیچش تصادفی در راستای : 97شکل
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 بارگذاری طیفی  در  Ŭبار با زاویه ورودی  تعریف الگوی 6-2-5

قاوم وقتی که سازه نامنظم در پلان و همچنین ستون در محل تلاقی دو سیستم م 2800نامه طبق آیین 

نی زلزله را اویه بحراجانبی باشد، باید نیروی جانبی زلزله با زاویه بحرانی به سازه اعمال گردد. اگر بخواهیم ز

اویهزر نهایت دعمال کرده و ا پیدا نمائیم می توانیم، الگوهای بارگذاری طیفی را در زوایای مختلف به سازه

 نمائیم. باشند تعیین نموده و سازه را تحلیله، پاسخهای سازه بیشینه مقدار میای را که در آن زاوی

 

 درجه 10تعریف الگوی بار  با زاویه : 98شکل

درجه تا زاویه  10و با اختلاف  xزاویه ها از محور 

 شود.درجه اعمال می 165
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 ها مقادیر بازتاب حاصلا  6-2-6

ادل ، برش پایه تحلیل استاتیکی معدر مواردی که برش پایه بدست آمده از روش تحلیل طیفی کمتر از 

 دار برش پایه تحلیل طیفی باید به مقادیر زیر افزایش داده شده بازتاب های سازه( باشد ، مق1-3رابطه )

ه بر ر برش پایمتناسب با آن ها اصلاح گردد .برش پایه استاتیکی معادل عنوان شده در ردیف های زیر ، مقدا

 خصات طیف استاندادر است .از مش( و با استفاده 1-3رابطه )اساس 

یا  نرم طبقه خیلییا  طبقه خیلی ضعیفدر سازه های نامنظم ، که نامنظمی در آنها از نوع  -الف 

ه برش پایه درصد نسبت برش پایه استاتیکی معادل ب 90نباشد ، مقادیر بازتاب ها باید در  پیچشی شدید

  اردمو  مشمول در سازه های نامنظمی که نامنظمی آنها تحلیل طیفی ضرب شوند . ولی  بدست آمده از

حلیل تآمده از  فوق الذکر باشد ، مقادیر بازتاب ها باید در نسبت برش پایه استاتیکی معادل به برش به دست

  طیفی ضرب شود .

ش به بر درصد نسبت برش پایه استاتیکی معادل 85در سازه های منظم ، مقادیر بازتاب ها باید در  ب 

 پایه بدست آمده از تحلیل طیفی ضرب شود .

از تحلیل  بند های الف و ب نباید از  برش پایه بدست آمدهی تعدیل شده در  تبصره : مقادیر برش پایه

 کیفی کمتر در نظر گرفته شود .

 

 اثرات پیچش 

مود . در منظور ن 7-3-3در روش تحلیل طیفی باید اثرات پیچش و پیچش اتفاقی را مشابه ضابطه بند 

 ان بای توممواردی که از مدل های سه بعدی برای آنالیز سازه استفاده می شود ، اثرات پیچش اتفاقی را 

 م طبقه به اندازه برون مرکزی اتفاقی منظور نمود.جابجا کردن مرکز جر

 ترکیب اثر زلزله در امتدادهای مختلف 

ائم اثر مؤلفه ق .اعمال شود  4-1-3بق ضوابط بند در تحلیل طیفی ، اثر زلزله در دو امتداد افقی باید مطا

 به صورت استاتیکی منظور گردد . 9-3-3زلزله نیز باید با توجه به بند 
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 روش تحلیل در سیستم دوگانه و یا ترکیبی 

رای ی شود ، بدر مواردی که برای تحمل بار جانبی زلزله از سیستم سازه ای دوگانه و یا ترکیبی استفاده م

صد برش پایه بدست آمده از تحلیل طیفی را به قاب های خمشی در 25پ باید -4-8-1ابطه بند اغناء ض

تفاده از یا با اس سیستم دوگانه اثر داد و نحوه توزیع این برش در ارتفاع را یا با استفاده از تحلیل طیفی و

 ، تعیین نمود . 6-3-3تحلیل استاتیکی معادل ، بند 

 

 (LRFDی)طراحی سازه های فولاد -7

 اعمال ضوابط طرح لرزه ای  7-1

ر نظر دلرزه ای نیز  طرح طبق مبحث دهم مقررات ملی ساختمان در طراحی سازه های فولادی باید ضوابط

 5قررار ملی ساختمان اگر ضریب رفتار ساختمان کمتر از مبحث دهم م 3-1-3-10گرفته شود. مطابق بند 

 لزامی نیست.باشد در نظر گرفتن ضوابط طرح لرزه ای ا

   به  شباهت زیادی  ح لرزه ایاز نظر ضوابط طر -1392مبحث دهم ویرایش   مقررات ملی ساختمان 

ر برنامه داد که به د، اما باید برخی تغییرات در ویرایش این آیین نامه دارد  AISC360-2010مه آیین نا

 .  ن می پردازیمشرح آ

 رابطه زیر می باشد : ترکیب بار تشدید یافته مبحث دهم مطابق دو

D + 1.2 L + 1.2 ɋ0 E 

0.85D + 1.2 ɋ0 E 

طابق منوال برنامه مطابق روابط زیر  م AISC360-05/IBC2006 ترکیب  بار تشدید یافته آیین نامه  

 می باشد :

(0.9 ï 0.2 SDS ) DL + ɋ0QE                                (ASCE  12.4.3.2) 

(1.2 + 0.2 SDS ) DL + ɋ0QE + 1.0 LL                (ASCE  12.4.3.2) 

 است . 2/0که مقدار آن به طور پیش فرض در برنامه برابر  DSSدر بالا یک ضریب وجود دارد تحت نام 

با هم تفاوتهایی  AISCهمانطور که دیده می شود ضریب بار مرده ، زنده وزلزله در مبحث دهم و آیین نامه

اینکه در ترکیب بار تشدید یافته نقش اصلی را بار زلزله دارد می توانیم از اختلافاتی دارد . البته با توجه با 
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که در زمینه ضرایب بارهای مرده و زنده وجود دارد صرفنظر کنیم و این ترکیب بارها را به عنوان ترکیب 

 بارهای تشدید یافته مورد نظر خود  قبول نماییم.

 

ک ضریب دید یافته مبحث دهم ، روش حالت حدی بار زلزله دارای ی: چون در ترکیب بارهای تش نکته مهم

ل مذکور ی برنامه وجود ندارد ، باید این ضریب را از جدواست که در ترکیب بارهای تشدید یافته  2/1

 ضرب کرده و سپس به برنامه وارد کنیم . 2/1استخراج کرده و در عدد 

 

 

 نواع سیستم های باربر جانبی لرزه ایبرای ا 0مقاومت  ضریب اضافه 2-2-3-10جدول 

 0 نوع سیستم باربر جانبی لرزه ای
 3 کلیه قابهای خمشی فولادی

 2 کلیه قابهای ساختمانی ساده توام با مهاربندی هم محورو برون محور فولادی

 5/2 کلیه سیستمهای دوگانه یا ترکیبی

 

 تحلیل مرتبه دوم 7-2

های زهسبت به روش تنش مجاز، اعمال آثار مرتبه دوم در طراحی سان LRFDیکی از تفاوتهای بارز روش 

اد شده باشد. در مبحث دهم مقررات ملی برای درنظر گرفتن آثار مرتبه دوم، سه روش پیشنهفولادی می

ژه برای در نظر گرفتن آثار مرتبه باشد. در این پرومی  AISC360-10 نامهاست که، همانند ضوابط آئین

 .شودتحلیل مستقیم استفاده می دوم، از روش

 روش تحلیل مستقیم 7-2-1

ماند و خطاهای هندسی بطور مستقیم در تحلیل سازه لحاظ میدر این روش اثرهای ثانویه، تنشهای پس

ای روش هیچ محدودیتی ندارد. در این روش  شود.شوند. در این روش از ضریب طول موثر استفاده نمی

( تحلیل سازه 2دسی)شمال کجی و ناشاقولی( در تحلیل مرتبه دوم منظور گردد. ( آثار نواقص هن1بایستی: 
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تحلیل  ( تحلیل مرتبه دوم بر اساس سختی کاهش یافته اعضا صورت گیرد.3از نوع تحلیل مرتبه دوم باشد. 

Pمرتبه دوم باید هر دو اثر  − δ   وP ï ȹ.روش تحلیل مستقیم در دو حالت سختی کاهش  را در برگیرد

یافته باید در همه اعضایی که سختی   EI*فته و سختی متغیر قابل انجام است. سختی خمشی کاهشیا

خمشی آنها در پایداری سازه مشارکت دارند، به جای سختی عادی انها بکار رود. در تحلیل و طراحی به 

سختی ایب کاهشروش مستقیم برای تعیین مقاومت مورد نیاز در تحلیل مرتبه دوم باید به شرح زیر از ضر

( علاوه بر ضریب 2برای کلیه سختی هایی که در پایداری سازه موثرند.  8/0 ( ضریب کاهش 1استفاده شود. 

نیز به شرح زیر در سختی خمشی اعضایی که در پایداری  휏، یک ضریب کاهش اضافی 8/0کاهش سختی 

 یا متغیر همانند رابطه زیر داشته باشد. تواند مقداری ثابت ومیاعمال شود. این مقدار  سازه موثرند

EI*= 0.8τ  EI      ,       휏 =   

 

 

مقاومت تسلیم محوری است. لازم به ذکر است که در تمام  Pمقاومت فشاری مورد نیاز و  P در رابطه فوق

بیش از حالت معمول،  50را %در نظر گرفت، به شرظی که بار جانبی مجازی  1را برابر  휏توان حالات می

 1 در مبحث دهم مقررات ملی ساختمان برابر مقدار  برابر بارهای ثقلی اعمال نمود. 003/0یعنی به مقدار 

باید برای اعضایی که سختی محوری  EA*کاهش یافته  سختی محوری در نظر گرفته شده است. همچنین

 یر در نظر گرفته شود.آنها در پایداری جانبی سازه مشارکت دارند بصورت ز

EA*= 0.8EA 

 انتخاب آیین نامه طراحی   7-3

 Options > Steel Frame Design > View/Revise Preferencesمسیر: 

در ادامه آورده  AISC360-10نامه تنظیمات مربوط به ضوابط طراحی لرزه ای بر اساس مبحث دهم و آئین

 شده است. 

1.0 ≤ 0.5 

 

4
αPu

Py
1 −

αPu

Py
            > 0.5 
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SMF :قاب خمشی ویژه 

IMF :قاب خمشی متوسط 

OMF :قاب خمشی معمولی 

SCBF :قاب مهاربندی همگرای ویژه 

OCBF :قاب مهاربندی همگرای معمولی 

OCBFI : قاب مهاربندی همگرای معمولی جدا

  سازی شده

EBF :قاب مهاربندی واگرا 

باید در نظر گزرفتن ضوابط لرزه ای ضریب رفتار سازه. برای -1

 وارد شود. 3بزرگتر از 

که مطابق جدول بالا باید با ضرب  0Ωضریب اضافه مقاومت -2

 وارد گردد. 2/1کردن به عدد 

ضریب افزایش تغییر مکان برای تبدیل تغییر مکانهای الاستیک -3

 (2800به غیر الاستیک)از جدول آئین نامه 

برای انجام تحلیل مرتبه دوم به روش تحلیل مستقیم باید 

 ت بصورت مقابل باشد.تنظیما

مقدار ضریب کاهش سختی ناشی از تنشهای پسماند یک 

 شود.درنظر گرفته می
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انتخاب شود ترکیبات  Yesدر صوزرتی که گزینه -1

 تشدید یافته ساخته نخواهند شد. 

انتخاب شود ضوابط لرزه ای  Yesدر صورتی که گزینه -2

 کنترل نمی شود.

ربرد دارد. این این گزینه تنها در قابهای خمشی کا-1

گزینه برای طراحی ضخامت ورق مضاعف کاربرد دارد. 

به این معنی است که ورق مضاعف  Yesانتخاب گزینه 

-به جان ستون با جوش کام و انگشتانه اتصال داده می

 به معنی جدا بودن این دو ورق است. Noشود. گزینه 

روش جوشکاری مقاطع جدار نازک توخالی در این -2

شود. وقتی جوشکاری از نوع یقسمت معرفی م

ERW قوس الکتریکی تحت حفاظت( باشد، ضخامت(t 

برابر ضخامت اسمی جداره و برای مقاطع  0.93باید 

-)قوس الکتریکی غوطه SAWجوشکاری شده به روش 

ور( ضخامت مزبور باید معادل ضخامت اسمی جداره در 

 نظر گرفته شود.

ورق در این قسمت کاهش و یا عدم کاهش ضخامت -3

ای( مشخص ای و جعبهمقطع جدارنازک بسته) لوله

شود. چون این کاهش در مبحث دهم اشاره نشده، می

 دهیم.قرار می Noمقدار آن را 
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 اختصاص پارامترهای طراحی   7-4

 هااختصاص پارامترهای طراحی ستون  7-4-1

 Design > Steel Frame Design > View/Revise Overwritesانتخاب ستونها و مسیر: 

 

 

 

اگر  وارد می شود. 1چون از روش تحلیل مستقیم استفاده شده است، پس مقادیر ضرایب طول موثر عدد 

 کند.وارد شود برنامه از مقدار آن صرفنظر کمی 1غیر از عددی به 
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 R10باشد که مقدار آن برای انواع مقاطع مورد استفاده در  جدول : ضریب تنش تسلیم مورد انتظار می-

 مبحث دهم مقررات ملی ساختمان آورده شده است. 3-2-1

 برای انواع تولیدات فولاد yRمقادیر  1-2-3-10جدول 

 yR صولنوع مح

 25/1 مقاطع لوله ای و قوطی شکل نورد شده

 20/1 شکل، ناودانی، نبشی و سپری Hشکل،  Iسایر مقاطع نورد شده شامل مقاطع 

 15/1 مقاطع ساخته شده از ورق ها و تسمه ها

 

 اختصاص پارامترهای طراحی تیرها  7-4-2

 Design > Steel Frame Design > View/Revise Overwritesانتخاب تیرها و مسیر: 

 

با توجه به اینکه در سقف تیرچه و بلوک بال 

فشاری تیرها در داخل بتن مدفون هستند، پس 

طول مهار نشده برای بال فشاری صفر است. لذا 

 شود.ار عددی نزدیک به صفر  وارد میافزدر نرم
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 اختصاص پارامترهای طراحی مهاربندها  7-4-3

 Design > Steel Frame Design > View/Revise Overwritesانتخاب مهاربندها و مسیر: 

 

 انتخاب ترکیبات طراحی  7-5

 Design > Steel Frame Design > Select Design Combinationsمسیر: 
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 طراحی سازه 7-5

 Design > Steel Frame Design > Start Design/Checkمسیر: 

 

 

 

 خروجی طراحی سازه 7-6

و به نسبت نیر Ratioانجام می شود. بوسیله  Ratioاز طریقکنترل طراحی مقاطع در سازه های فولادی  

حد  ظرفیت در اعضا مشخص شده و مقاطع از نظر طراحی بررسی می گردد. اگر نسبت نیرو به ظرفیت در

ی نمود. در توان مقاطع را قابل قبول تلقمیاقتصادی باشد،  بوده و 1باشد، یعنی کوچکتر از  قبول قابل

تغییر یابند.  باشد مقاطع از نظر طراحی جوابگو نیستند و باید 1صورتی که نسبت نیرو به ظرفیت بزرگتر از 

 که در ادامه نحوه تغییر مقاطع المانها توضیح داده خواهد شد.
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 Design > Steel Frame Design > Display Design Infoéمسیر: 

 

 

د این مقاطع می باشد که بای 1چنانچه مشاهده می شود. در بعضی از مقاطع نسبت نیرو به ظرفیت بزرگتر از 

 نزدیکتر باشد اقتصادی تر می باشد. 1به  Ratioتغییر یابند. لازم به ذکر است که هرچقدر 

 تیپ بندی مقاطع 9-6

را تیپ بندی و اجرائی نمود. باید دقت کرد  نظر طراحی مناسب بودند باید مقاطعآنکه تمام مقاطع از  بعد از

در طبقاتی که قرار است در  ستونهای آنها  از یک شماره پروفیل استفاده  ،در سازه های فولادی تیپ بندی
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ای داخلی المانها از ورقهای توان برای جبران نیازهشود. در هنگام تیپ بندی مقاطع می، انجام میشود

 تقویتی استفاده کرد.

 مسیر: با کلیک راست در روی عضو پنجره زیر باز می شود.

 

 

می توان از این قسمت اقدام به تغییر مقطع 

عضو انتخاب شده نمود. در صورتی که 

مقطع جدید از نظر طراحی قابل قبول 

نمایش داده  1ان بزرگتر از  Ratioنباشد 

 شود.می
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 نمایش مقاطع طراحی 9-7

 Design > Steel Frame Design > Display Design Infoéمسیر: 

 

 

 تغییر مقاطع  9-8

وش دیگر ردر مرحله تیپ بندی گفته شده است. دو برای تغییر مقاطع سه روش وجود دارد که یکی از آنها 

 بصورت زیر می باشد.

 تغییر مقاطعی که از نظر طراحی جوابگو نیستند.روش اول: 
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 Design > Steel Frame Design > Change Design Section انتخاب المانهای مورد نظر مسیر: 

 

ت ین تفاوا طی می شود. با  Start Design  سیر دوباره سازه را م Okبعد از انتخاب مقطع مورد نظر و زدن 

 وند.مقاطعی که انتخاب شده و مقطع آنها تغییر پیدا کرده است، طراحی می شکه در این مرحله فقط 

ستفاده اروشهای قبلی در صورتی قابل استفاده است که از روش اول اختصاص مقاطع در پروژه روش دوم:  

د، قابل روشهای قبلی در صورتی که مقطعی جدید قبلا تعریف شده باشنماییم. یعنی روش تغییر مقطع با 

( Add Auto select Listاستفاده است. اما وقتی از روش دوم اختصاص مقاطع، در پروژه  استفاده کرده ایم)

. پس کندخاب میو فقط المان مناسب را انت آزمایدار بصورت خودکار برای المانها میتمام مقاطع را نرم افز

قفل  ا باز کردنماند و در صورتی که مقاطع جوابگو نباشند، باید بدیدی برای بررسی دوباره باقی نمیمقطع ج

 برنامه و تعریف نمودن مقاطع جدید، مراحل تحلیل و طراحی سازه دوباره صورت گیرد.
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 مدلسازی، تحلیل و طراحی سازه های بتنی  10

وارد مشابه برای سازه های بتنی و فولادی در اکثر م Etabsازه در تمام گامهای گفته شده برای مدلسازی س

 در بعضی از گامها تفاوتهایی باهم دارند که در زیر آورده می شود.ند. فقط می باش

برای سازه بتنی، شروع به مدلسازی می کنیم. مراحل مدلسازی قبلا  Defineبعد از تکمیل کردن منوی 

 گفته شده است.

 

 

 

 

 ل ضرایب ترک خوردگیاعما 10-1

 در سازه های بتنی ضرایب ترک خوردکی برای دو هدف متفاوت اعمال می شود.

 هدف اول: برای پیدا کردن زمان تناوب واقعی سازه

 Tزمان تناوب اصلی سازه، 3-3-3

اثر ترک  : در محاسبه زمان تناوب اصلی سازه های بتنی ، بمنظور در نظر گرفتن سختی مؤثر در 3تبصره 

 Igرها و برای ستون ها و دیوا Ig5/0ردگی بتن ، لازم است ممان اینرسی مقاطع قطعات برای تیرها خو

رابر مقادیر ب 5/1ممان اینرسی مقطع کل عضو بدون در نظر گرفتن فولاد است . این مقادیر  Igمنظور شود . 

 برای مقاطع ترک خورده است. 5-6-3مندرج در بند 

 رل تغییر مکان جانبی سازههدف دوم: برای طراحی و کنت

طع ترک ح ، ممان اینرسی مقدر سازه های بتن مسلح در تعیین تغییر مکان جانبی نسبی طر 3-5-5

 Ig ی ستون ها، براIg  35/0برای تیرها «آبا »مطابق توصیه آیین نامه بتن ایران  ،انتوخورده قطعات را می

بهره   زلهبرای زل ، منظور کرد .ترک خوردگی میزان   نسبت بهIg 7/0یا Ig  35/0، و برای دیوارها  7/0

 صرفنظر کرد. P-æبرابر افزایش داد و از اثرات  5/1برداری مقادیر این ممان اینرسی ها را می توان تا 

 ید تیرهای بتنی آزاد سازی گردند.با توجه به اینکه اتصالات سازه های بتنی گیردار می باشند، نبا: 1نکته 

 Etabsدر . بهتر است، مقاطع برای اعضای هر طبقه توسط طراح اختصاص داده شوددر سازه های بتنی برای اختصاص  مقاطع : 2نکته 

 استفاده کرد.نیز  Add Auto Select Listمی توان از طریق  2013

ضرایب ترک خوردگی مقاطع  2800تن سختی واقعی مقاطع باید طبق آئین نامه در مدلسازی سازه های بتنی، برای در نظر گرف:3نکته 

 اعمال شود. 
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 اعمال ضرایب ترک خوردگی تیرها 

 Assign > Frame  > Property Modifiers مسیر: انتخاب تیرها 

 

  تونهاساعمال ضرایب ترک خوردگی 

     Assign > Frame  > Property Modifiers     ستونها              مسیر: انتخاب 
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 بعد از بارگذاری و اتمام مدلسازی سازه همانند بندهای گفته شده در جزوه تحلیل می شود.

  

 

 طراحی سازه های بتنی 10-2

 انتخاب آئین نامهگام اول: 

ن ی که امکافته شده است، سازه های ساخته شده در کشورمان باید تا جایهمچنان که در ابتدای جزوه نیز گ

داخلی  هاینامهنها که در اجرا بر اساس آئیل سازهدارد بر اساس آئین نامه های داخلی ساخته شوند؛ تا کنتر

از توان ی براساس مبحث نهم مقررات ملی میگیرد دچار تردید نشود. برای طراحی سازه های بتنصورت می

هم مقررات ن( استفاده کرد. اکثر ضوابط مربوط به طراحی سازه های بتنی مبحث CSAنامه بتن کانادا)آئین

 باشد.کانادا میملی شبیه آئین نامه 

های ازهساما از آنجا که مهندسین محترم کنترل کننده در سازمان نظام مهندسی تمایل زیادی به طراحی 

ح میمریکا تشریآنامه یکا دارند، لذا در این جزوه نیز طراحی بر اساس آئیننامه بتن آمربتنی بر اساس آئین

 گردد.

 Design > Concrete Frame Design >View/Revise Preferencesمسیر: 

  

 -Pدر منوی تنظیمات تحلیل برای سازه های بتنی باید دقت داشته باشیم که، در مرحله مربوط به تنظیمات : 4نکته 

 ترکیبات بار مربوط به سازه های بتنی باید اعمال گردد.
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 گام دوم: انتخاب ترکیبات طراحی

 Design >Concret Frame Design > Select Design Combinationsمسیر: 

 

  ی بتنیپذیری سازهتعیین شکلگام سوم: 

 Design >Concrete Frame Design >View/Revise Overwrites مسیر: انتخاب کل سازه 

 

 

Sway Special پذیری ویژه= شکل 

Sway Intermediate شکل پذیری  متوسط = 

Sway Ordinary شکل پذیری کم = 
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 شروع طراحیگام چهارم: 

 Design > Concrete Frame Design > Start Design / Checkمسیر: 

 

 های بتنیازهخروجی طراحی س  10-3

 اتورهای طولیخروجی آرم  10-3-1

 Design > Concrete Frame Design > Display Design Infoéمسیر: 
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 آرایش میلگردهای طولی تیرها 

وان بعن در شکل قبلی میلگردهای طولی برای هر تیر، در سه مقطع بحرانی نشان داده شده است.

 صورت زیر  عمل می کنیم: شده در شکل قبل به صمثال برای مقطع مشخ

As = 1604 mm2 Use = ű16 As= 200.96 mm2 

 = تعداد
.
≅ 8                 As Prov =1607.68 mm2 > 1604 mm2                  OK 
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 و بصورتی لازم به ذکر است که در تیرهای سراسری سازه های بتنی، آرایش مقاطع باید برای کل تیر یکجا

ه لی در رابطمنیز باید تمام ضوابط مبحث نهم مقررات که قابل اجرا باشد، صورت گیرد. برای قطع میلگردها 

 با قطع میلگردها رعایت شود.

 

 

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̹̿ 
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  ستونهاآرایش میلگردهای طولی 

  است با توجه به اینکه در تعریف مقاطع ستونها، تعداد میلگردهای طولی مشخص شده است، کافی

 تعیین شود. شماره میلگردها

As = 4886 mm2               Defined 10 Bars           As (one bar) = 488.6 mm2  

Use = ű25                 As=490.625 mm2               As Prov=4906.25mm2> 4886 mm2               OK 
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 کنترل درصد هندسی فولاد  10-3-2

 Design > Concrete Frame Design > Display Design Infoéمسیر:

 

 

های بتن آرمه مقدار هندسی فولاد در مقاطع، باید کمتر از مقادیر بالانس با توجه به ضوابط طراحی سازه

 باشد؛ تا شکست المانها، شکست کششی و نرم باشد.
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 کنترل درصد هندسی فولاد در تیرها 

ρ ≤ ρ ≤ ρ  

 

ρ = 훼 훽
휑 푓

휑 푓
.
700

700. 푓
 

ρ =
ρ
b

,
0.025

 

 

훼 = 0.85 − 0.0015푓 ≥ 0.67 

 

훽 = 0.97 − 0.0025푓 ≥ 0.67 

سطح مقطع کل 06/0و بیشتر از  01/0در قطعات فشاری سطح مقطع آرماتورهای طولی نباید کمتر  از   9-14-9-1

در  S400کثر باید در محل وصله های پوششی میلگردها نیز رعایت شود.در صورت امکان از فولاد باشد.محدودیت مقدار حدا

 سطح مقطع کل محدود می گردد. 045/0آرماتورهای طولی مقدار حداکثر در خارج از محل وصله ها به 

 

 

 

 گردهای عرضیکنترل میل  10-3-3

 Design > Concrete Frame Design > Display Design Infoéمسیر:

 

 دهد.را نمایش می  افزار برای میلگردهای عرضی نرم

 لازم به ذکر است که مقدار حداکثر فولاد در قطعات فشاری باید در محل وصله ها نیز کنترل گردد.نکته:  
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 آرایش میلگردهای عرضی تیرها 

푨풗

풔
 = 0.35                 Use = ű8                Av = 100.48 mm2                S=

.

.
 ≤ 푆  

S =min

⎩
⎪
⎨

⎪
⎧

d
2 
,

fyv×Asv

0.06 ×√fc ×bw⎭
⎪
⎬

⎪
⎫

 

 آرایش میلگردهای عرضی ستونها 

L=max
یک ششم ارتفاع یا دهانه آزاد عضو

ضلع بزرگتر مقطع

450 푚푚

, 푆 =푚푖푛

⎩
⎪
⎨

⎪
⎧

6푑푠
24푑푏
250푚푚

⎭نصف کوچکترین بعد مقطع ستون
⎪
⎬

⎪
⎫

 

 

퐿  

퐿  

اساس بر باید به ذکر است که خاموت گذاری در طول بحرانی نشان داده شده  لازمنکته: 

 ضوابط بالا انجام شود. ولی در هر حالت نباید کمتر از مقادیر مورد نیاز برای طراحی باشد.
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متر  از اساس طراحی بدست می آید که در هر حالت نباید ک برای قسمت میانی نیز خاموت مورد نیاز بر 

  مقادیر خاموت حداقل باشد.

 عیف و ستون قویضکنترل تیر  10-3-4
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 Design > Concrete Frame Design > Display Design Infoéمسیر:

 

  

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̀͊ 
 

   

 

 

یم ترس 90سازه فزار ایران سازه یانرم ا های اجرایی آن توسطهای بتنی نقشهبعد از کنترل خروجی های سازه

 یرادهای جدیافزارها در موقع ترسیم بعضا دارای اگردد. لازم به ذکر است با توجه به اینکه این نرممی

بحث نهم ای و اجرایی، جزئیات توسط مهندس محاسب مطابق با مهای سازههستند باید بعد از تهیه نقشه

 مقررات ملی ساختمان کنترل گردد.
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 طراحی دیوار برشی 11

ر برشی اده از دیواهای بتنی و فولادی از دیوار برشی استفاده نمود. استفتوان در سازهبنابه دلایل مختلف می

ه از امل استفادهای بتنی  در کاهش ابعاد المانهای تیر و ستون بسیار تاثیر گذار است. از جمله عودر سازه

 لایل زیر اشاره نمود.توان به دها میدیوار برشی در سازه

 های نسبتا بلندکاهش ابعاد تیر و ستون بتنی در سازه -

 نیاز افزایش ظرفیت باربری جانبی سازه -

 محدودیتهای معماری جهت بزرگ نمودن ابعاد المانهای قاب خمشی -

 هاکاهش و کنترل جابجایی جانبی سازه -

 و غیره ... -

 :برشی دیوارهای قرارگیری جهت مناسب مکان انتخاب  11-1

 .است ارجح کوتاه هایدهانه به نسبت بلند هایدهانه در برشی دیوار قرارگیری .1

 .است ارجح متوالی هایدهانه در برشی دیوار قرارگیری .2

 و جرم کزمر بین و باشد منظم سازه که باشد ایگونه به است بهتر برشی دیوار محلهای انتخاب طرز .3

 .نیافتد فاصله سختی

 .شود اضافه تدری  به پایین به بالا طبقات از برشی دیوار هایدهانه تعداد است بهتر .4

 .ردندا وجود موضوع این برای منعی چند هر گیرند قرار ستونها بین برشی دیوارهای است بهتر .5

 :یبرش وارید برای ازین مورد طول هیاول برآورد و بیتقر 11-2

 ساختمان قابهای که شودیم باعث انهدوگ ستمهاییس در وارید برای لازم طول هیاول برآورد و بیتقر

 لازم طول هیاول کردن محاسبه کهیبطور. شوند طرح یجانب باربری 75%  برای یبرش وارهایید و 25%برای
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 در یبرش وارید برای ازین مورد طول. کرد خواهد تیهدا نهیبه طرح کی سوی به را طراح ،یبرش وارید برای

 :دیآیم بدست ریز یبیتقر رابطه از استفاده با جهت هر

 

  tw تنش تسلیم آرمانورهای افقی دیوار، fyمقاومت فشاری مشخصه،  fc، در راستای مورد نظر برش پایه V: در رابطه بالا

 شده بینی پیش افقی آرماتور نسبت و ∝، میدهیم قرار سانتیمتر 25 برابر معمولاً که است دیوار ضخامت

 یک در برشی دیوار افقی آرماتور مقدار .باشندمی نامه آیین داقلح آرماتور به نسبت دیوارن پایی تراز در

 حداقل آرماتور) اینامه آیین حداقل مقدار برابر 3 تا 2 حدود چیزی در پایین، طبقه در متعارف ساختمان

 .باشدمی( 0.0025 برابر آییننامه

 هر در و شود گرد بالا سمت به آن مقدار ستیبایم د،یآیم بدست وارید برای بالا رابطه از که یطول مقدار

دست آمد، ب متر wL 6,3 رمقدا اگر مثال طور به. آمد، بدست برابربطور جداگانه تامین شود.  X و Y جهت

 ماریمع ضوابط لیدل به چنانچهجانمایی شود.  X و Y امتداد هر در یبرش وارید متر 7 مقدار یستیبا

 شما ساختمان که دینباش نگران د؛یینما نیتام جهت دو هر ای کی در را یبرش وارید از مقدار نیا دینتوانست

 شده مترک هیپا برش از شما ساختمان یبرش وارید سهم بلکه ست،ین یجانب بار از حاصل برش تحمل به قادر

 شما اختمانس قابهای سهم یعنی. ندیآیم بدست بزرگتر قابها مقاطع جهینت در و گرددیم شتریب قابها سهم و

 .شد خواهد 75%  از کمتر وارهاید سهم و 25%  از شتریب یجانب یباربر در

 تعیین ضخامت دیوار 11-3

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̸̀̀ 
 

 مدلسازی دیوار برشی 11-4

 

 Draw > Draw Floor/ Wall Objectsمسیر: 

 توان دیوارها را ترسیم نمود.یا از طریق ابزارهای زیر می

 

 

 

 گیضرایب ترک خورداختصاص  11-5

 

و در صورتی که  35/0در صورتی که دیوار برشی ترک بخورد، ضریب  2800نامه ق از آیینبا توجه به بند فو

اعمال خواهد شد. بر اساس مبحث نهم مقررات ملی ساختمان، تنش ترک  7/0دیوار ترک نخورد ضریب 

ده محسوب باشد دیوار ترک خور rfبزرگتر از  2f-2باشد. پس اگر تنش می 푓0.6=  rfخوردگی بتن برابر 
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اعمال  7/0شود. ابتدا ضریب ترک خوردگی دیوار شود و اگر کمتر باشد دیوار ترک خورده محسوب نمیمی

شود، سپس بعد از تحلیل تنش دیوار کنترل خواهد شد؛ اگر ترک خورده باشد، ضریب ترک خوردگی می

 شود.اعمال می 35/0دوباره اصلاح شده و ضریب 

 Select > Select > Object type > Wallsانتخاب دیوارها از مسیر: 

 Assign > Shell > Stiffness Modifiersاختصاص ضریب ترک خوردگی از مسیر: 

 

 بندی دیوارهامش 11-5

 Select > Select > Object type > Wallsانتخاب دیوارها از مسیر: 

 Edit > Edit Shells > Divide Shells: بندی از مسیراختصاص مش

 

 بندی افقیمش بندی قائممش
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اشد که متر و بصورت مربعی انتخاب شود. یعنی تقسیم بندی طوری ب 5/0بهتر است ابعاد مشها در حدود 

های قائم نیز شگاه مذکر است که تکیهمتر باشد. همچنین لازم به 5/0ابعاد مشها بصورت مربعی و اندازه آن 

ای گاه برکیهن منظور همانند اعمال تمشکل و خطایی بوجود نیاید. برای ایگیردار شود تا در نتای  طراحی 

 ر خواهد بود.گاه گیردار بصورت زیاقدام خواهیم کرد که بعد از اختصاص تکیه Base Storyستونها از طبقه 

 

 



 محمدپور                                                              Etabs 2015جزوه نرم افزار

 

̷̹̹ 
 

 ر برشیایجاد بازشو در دیوا  11-6

ات م مقررحث نهبایست بر اساس مبتوانند بازشو داشته باشند. لذا میبنابه دلایل مختلف دیوارهای برشی می

بعد  رهای برشیملی ساختمان، بازشو نیز در مدلسازی دیوارها در نظر گرفته شود. برای ایجاد بازشو در دیوا

جاد د نظر را ایتوان بر اساس ابعاد بازشو، تعدادی از مشها را حذف کرده و بازشو موربندی میاز ایجاد مش

 نمود.

 

 نامگذاری دیوارها 11-7

 امکان فقط ندارد محاسبات در رییتاث نامگذاری نیا) کرد نامگذاری را آنها دیبا یبرش وارهایید یطراح برای

 دیبا وارهاید با زین یبرش وارید اطراف ستونهای(. دیآیم وجود به یبرش وارهایید یطراح و یخروج

 برای. میکن فیتعر نام کی آن اطراف یخط ستونهای و یسطح وارید هر برای ستیبایم که شوند نامگذاری

 :میدهیم انجام را ریز مراحل کار نیا
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رهایی ا در دیوادیوارهایی که بازشو ندارند باید یک نام برای کل دیوار در همه طبقات اختصاص داده شود. ام

 نام یگریدکه بازشو دارند طرفین تیر کوپله بصورت جداگانه نامگذاری شده و خود تیر کوپله هم با نام 

 نام Spandrelعنوان و برای تیرهای کوپله از  Pierنامگذاری دیوارها از عنوان  برای گذاری خواهند شد.

ختصاص داده ادیوار وجود دارد که باید برای هر کدام یک نام جداگانه  4در این پروژه  گذاری خواهند شد.

رها به ترتیب از اباشد پس برای دیودیوار برشی دارای بازشو می 1شود؛ ولی با توجه به اینکه در دیوار محور 

س در در کل شود. همچنین با توجه به اینکه در یک دیوار بازشو داریم، پاستفاده می P5الی   P1بر چسب 

بعد از  .استفاده خواهد شد S1یک تیر کوپله در این پروژه وجود دارد. لذا فقط از  یک برچسب با نام 

 شود.انتخاب هر دیوار بصورت زیر نامگذری می

 Assign > Shell > Pier Lableé: ص برچسب دیوارهااختصا مسیر

 Assign > Frame > Pier Lableéمسیر اختصاص برچسب ستونهای کنار دیوارها: 

 Assign > Shell > Spandrel Lableéمسیر اختصاص برچسب تیرهای کوپله:  

 ته باشد.لازم به ذکر است که ستونهای کناری هر دیوار باید متناسب با آن دیوار برچسب داش

 

 شود.برای افزودن بر چسب ها از این گزینه استفاده می
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 تحلیل سازه و کنترل تنش ترک خوردگی دیوار 11-7

ن ود. در ایشبرای انجام تحلیل سازه دارای دیوار برشی، همانند مطالبی که قبلا گفته شده است اقدام می

 شود.مرحله برای کنترل تنش در دیوار و بررسی ترک خوردگی دیوار بصورت زیر اقدام می

  Display > Force/Stress Diagrams > Shell Stresses/Forcesمسیر: 

 برچسب ستون

برچسب 

 تیر کوپله
 برچسب دیوار

-دیوار و ستون هم برچسب

 نام هستند

 افزار نیز اصلاح گردد.دا محاسبه شده و در نرمقبل از تحلیل سازه باید دقت کنیم که ضریب برش پایه برای سیستم دوگانه مجدنکته: 
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خوردگی برابر در نظر گرفته شود، در نظر گرفته شود، تنش ترک Mpa 25اگر مقاومت فشاری بتن برابر 

نشان  Shellخواهد بود. بنابراین بر حسب تنشهایی که در روی المان  3Mpaخوردگی برابر  تنش ترک

 35/0خوردگی  هر جایی که تنش بیشتر از مقدار تنش خوردگی باشد، بایستی ضریب ترک شود درداده می

 اعمال شود.
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وده؛ پس شود، مقدار تنش ایجاد شده در دیوار کمتر از مقدار تنش ترک خوردگی بهمچنان که مشاهده می

 باشد.خوردگی لازم نمیتغییر  ضریب ترک

 

 طراحی سازه 11-8

الت بدون مهای دوگانه باید دقت نمائیم که، ابتدا باید قاب خمشی بتنی همانند حدر مرحله طراحی سیست

ه در کهای آن کنترل گردد. سپس دیوار برشی بطور جداگه همانند مراحلی دیوار برشی طراحی و خروجی

 ادامه اورده شده است طراحی گردد.
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 تنظیم پارامترهای طراحی  11-8-1

مترهای طراحی نامه پاراشود. لذا بر اساس این آئیناستفاده می ACIنامه نبرای طراحی دیوار برشی از آئی

 گردد.تنظیم می

 Design > Shear Wall Design > View/Revise Preferencesمسیر انتخاب: 

 

         

 درصد هندسی فولاد در المان مرزی کششی

 درصد هندسی فولاد در المان مرزی فشاری
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باید در محل  مقداردرصد در نظر گرفته شود. با توجه به اینکه این  4درصد میلگرد در دیوار نباید بیش از 

  شود.درصد محدود می 2وصله ها نیز در نظر گرفته شود؛ لذا این مقدار به 

 یب بارهای طراحیانتخاب ترک 11-8-2

  Design > Shear Wall Design >Select Design Combinationsمسیر انتخاب: 

 

 

 ردیوادرصد هندسی فولاد در 

 حداقل درصد هندسی فولادهای برشی
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 انتخاب روش طراحی 11-8-3

توان دیوارهای برشی را طراحی نمود. هر کدام از این روشها به سه روش متفاوت می  Etabsافزار در نرم

 Simplified C and Tدارای مزیتهای مختلفی هستند. در دیوارهای برشی متعارف استفاده از روش 

Section برای اختصاص روش طراحی، ابتدا دیوارها انتخاب شده و از مسیر زیر روش  باشد.تر میمناسب

 د:شوطراحی اختصاص داده می

  Design > Shear Wall Design >Assign Pier Section > Simplified C and T Sectionمسیر: 

 صات دیوار برای طراحیانتخاب مشخ 11-8-4  

ها را برای اعمال مشخصات دیوارها در این روش طراحی بایستی طول اجزای مرزی و سایر مشخصات دیوار

 تصاص دادهی دیوار انتخاب و سپس از مسیر زیر مشخصات آن اخوارد نمائیم. برای این منظور ابتدا بایست

 شود.

 Design > Shear Wall Design > View/Revise Pier Overwritesمسیر: 
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رت بالا وارد بصو DB2و  DB1باشد، لذا می 50 *50با توجه به اینکه در این پروژه ابعاد ستونهای انتهایی 

 گردیده است.

 شود.مشخصات دیوار، طراحی دیوارها از طریق منوی زیر انجام می بعد از اختصاص

 Design > Shear Wall Design > Start Design/Checkمسیر: 
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باشد و لازم به ذکر است که در این روش طراحی، میلگردهای طراحی شده فقط برای دو انتهای دیوار می

یه استفاده منامیانی دیوار از میلگرد حداقل آئینشود. برای قسمت مگذاری نمیقسمت میانی دیوار میلگرد

 شود.

 ات آرماتورهاکنترل خروجی طراحی دیوار برشی و تعیین مشخص 11-8-5

 شود:برای بررسی خروجی طراحی دیوارهای برشی از مسیر زیر استفاده می

 Design > Shear Wall Design > Display Design Infoéمسیر: 

 های دیوارمیلگردهای طولی دو انت -1
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ر سمت انتهای دیوار دتوان گفت که مقدار سطح مقطع میلگردهای طولی با توجه به شکل بالا می

 ود.شباید قرار داده  DB1باشد که در طولی برابر با میلیمتر مربع می 6284راست برابر با 

 

 میلگردهای برشی دیوارها -2

 

 

 کنترل تغییر مکان جانبی سازه 11
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ست دعمال بار جانبی زلزله به ن جانبی طبقه در اثرزلزله ، تغییر مکانی است که در اثر اتغییر مکا 3-5-1

زه می آید. در تحلیل خطی )استاتیکی یا دینامیکی( تغییرمکان جانبی طبقه با فرض رفتار خطی سا

ت که در صور تغییر مکان جانبی غیر خطی طرحمی شود . در زلزله طرح برای بدست آورد  ،محاسبه

ایی تغییر مکان جانبی خطی باید در ضریب بزرگنم منظور داشتن رغتار غیرخطی سازه بدست می آید ،

 است. ( ارائه شده3-5، ضرب شود . این ضریب برای انواع سیستم های سازه ای در جدول ) dCتغییرمکان ، 

ف های بالا و پایین بی مراکز جرم کتغییر مکان جانبی نسبی هر طبقه اختلاف تغییرمکان های جان 3-5-2

یرمکانی ، در هر طبقه تغی تغییر مکان جانبی نسبی غیرخطی طرح  آن طبقه می باشد . در زلزله طرح 

با  ه در صورت منظور داشتن رفتار غیر خطی سازه ، بدست می آید .در مواردی که تحلیل سازهاست ک

 د.توان از رابطه زیر بدست آور استفاده از روش های خطی انجام می شود ، این تغییرمکان را می

                    M = Cd . æe       )10-3( 

 در این رابطه :

M =تغییر مکان جانبی نسبی غیرخطی طرح در طبقه 

eæزله طرحتغییر مکان جانبی نسبی طبقه حاصل از تحلیل خطی در زل 

dCضریب بزرگنمایی تغییر مکان 

  ( که بتا 6-3)موضوع بند  æ-P تتغییر مکان جانبی نسبی غیر خطی طرح با در نظر گرفتن اثرا 3-5-3

Mæ نشان داده می شود ، در هر طبقه نباید از مقادیر مجاز a .بیشتر شود ، 

 aه = برابر ارتفاع طبق 025/0         طبقه 5برای ساختمان های تا 

aبرابر ارتفاع طبقه =  02/0                     برای سایر ساختمان ها

رش پایته ، برای رعایت محدودیت های فوق ، مقدار بeæ محاسبه تغییر مکان نسبی هر طبقه : در 1تبصره 

 در T ( را می توان بدون منظور کردن محدودیت مربوط بته زمتان تنتاوب اصتلی ستاختمان1-3)در رابطه 

. ولی در ساختمان های با اهمیت خیلی زیاد محدودیت آن بنتد در متورد  تعییین کرد 3-3-3بند  1تبصره 

اقل برش در خصوص حد 1-3-3( از بند 2-3زمان تناوب اصلی باید رعایت شود . در هر حال رعایت رابطه )

 پایه در محاسبات تغییر مکان نسبی ضروری است .
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نستبی   نظم پیچشی و یا نامنظم شدید پیچشی ، برای محاسبه تغییتر مکتان:در ساختمان های نام 2تبصره 

مکانهتای  فاوت بین تغییر مکان های جانبی مراکز جرم کف ها ، تفاوت بتین تغییتربه جای ت، eæهر طبقه 

 یرد.آن طبقه در امتداد محورهای کناری ساختمان باید مد نظر قرار گجانبی کف های بالا و پایین 

زه ای آنهتا برای ساختمان های واقع در مناطق با خطر نسبی خیلی زیاد و یا زیاد که سیستم ستا:  3تبصره 

 تقسیم شود .  باید بر ضریب نامعینی  aصرفا از قاب های خمشی تشکیل شده باشد مقدار 

زیر که از تحلیل خطی سازه  رداری بتغییر مکان جانبی نسبی بهره  در زلزله سطح بهره برداری  3-5-4

حتدودیت را در مارتفاع آن طبقه بیشتر باشد. ایتن  005/0اثر نیروی زلزله مذکور به دست می آید ، نباید از 

ه ایتن کتمواردی که نوع و نحوه بکارگیری مصالح و سیستم اتصال قطعات غیر سازه ای بته گونته ای باشتد 

 008/0ن تتا ، برجتا بماننتد متی تتوا قطعات بتوانند در برابر تغییر مکان جانبی بیشتر ، بدون خسارت عمده

 ارتفاع طبقه افزایش داد .

متان اینرستی مقطتع تترک مدر سازه های بتن مسلح در تعیین تغییر مکان جانبی نسبی طترح ،  3-5-5

بترای ستتون  ، Ig  35/0برای تیرهتا «آبا  »خورده قطعات را می توان ، مطابق توصیه آیین نامه بتن ایران 

ای زلزله بهره نسبت به میزان ترک خوردگی ، منظور کرد .برIg 7/0یا Ig  35/0دیوارها ، و برای  Ig 7/0ها

 رفنظر کرد.ص P-æبرابر افزایش داد و از اثرات  5/1برداری مقادیر این ممان اینرسی ها را می توان تا 

بتا ن هتای د طبقته و یتا در ستاختمابا هر تعدا زیادو  خیلی زیاددر ساختمان های با اهمیت  3-5-6

ییتر مکتان بیشتر از هشت طبقه ، عرض درز انقطاع بین ساختمان و ساختمان مجاور بایتد بتا استتفاده از تغ

 حاسبه ایتنجانبی غیرخطی طرح در طبقه )با در نظر گرفتن اثرات ( تعیین شود . برای این منظور پس از م

ه اع استتفادعدد برای تعیین درز انقطت تغییر مکان برای هر دو ساختمان می توان از جذر مجموع مربعات دو

ز انمود . در صورتیکه مشخصات ساختمان مجاور در دسترس نباشد ، حتداقل فاصتله هتر طبقته ستاختمان 

 .آن طبقه ساختمان باشد مقدار تغییر مکان جانبی غیر خطی طرح در %70زمین مجاور باید برابر 

 طیحاصل از تحلیل خجانبی نسبی  نمایش تغییر مکان 11-1

   Display > Show tablesمسیر: 
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Ex:x رای راستایب  

Ey:y رای راستایب  

 اگر بخواهیم میانقابها مانع حرکت قاب نشوند، چه مقدار فاصله مابین قاب و میانقاب لازم است؟سوال: 
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 کنترل خروج از مرکزیت تصادفی در مرکز جرم و سختی12 

 Display > Show tablesمسیر: 

 

 

 کنترل واژگونی سازه  13

 

 

 مراکز سختی مراکز جرم
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 گروه مهندسی سیویل سایمان 

 

 سوپر گروه مهندسی سیویل سایمان 

https://telegram.me/joinchat/BOgacj1yMgCp5vvngENB0g 

 کانال سیویل سایمان 

https://telegram.me/civilsayman 

 وبسایت گروه مهندسی سیویل سایمان 

ivilsayman.comwww.c 

 

 

https://telegram.me/joinchat/BOgacj1yMgCp5vvngENB0g
https://telegram.me/civilsayman
www.civilsayman.com
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           دوره های در حال ثبت نام گروه مهندسی سیویل سایمان 
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